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1.01 System requirements and product details

System Windows XP, Vista, 7. 8 or 8.1; for Mac OS X, a Windows emulator is required
requirements

Licence One-time purchase, unlimited use

Delivery Registration key via email

Supported Index (V2, W3 and W4), ViewPlus (all models), Enabling (all models), Elotype. Gemini,
embossers Mountbatten Brailler

Available Arabic, Chinese, Czech, Danish, Dutch, English, French, German, Hindi, ltalian. Japanese,
languages Korean, Norwegian, Polish, Portuguese, Russian, Spanish, Swedish, Turkish

File formats TactileView files (_bpx); import .txt, .svg, jpg, .png. .bmp, tiff or gif

Internet TactileView can be used offline, but specific functions (e.a. map maker, designs catalog) require
requirements internet access

Software A reqistration key is valid for software registration on one computer only

security

3/187



TactileView softwar e manual
Visit us at http://thinkable.nl

1.02 Downloading TactileView
The Tactileview software is available for download and installation on Windows computers.

The software is compatible with Windows XP, Windos 7, 8 and 8.1. For use with other operating
systems, you will need a Windows emulator (such as Boot Camp or Parallels for Mac OS X).

Freetrial

The software can be launched in demonstration mode without registration. All features are available,
however files cannot be saved and prints will contain watermarks. In order to run the software in full
version, you need a software product code (SPC). Y ou can purchase a software product code (SPC) in the
Thinkable shap.

Download

Click hereto visit the download page in case you have not yet downloaded the software.

Please note that administrator rights are required to install the software on your computer.
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1.03 Installing softwar e (fir st time)

To install the software after downloading, launch the TactileView installer from the USB drive or
download folder. Follow the on-screen prompts to complete the installation. On the last screen, choose
'Finish', then launch the software from the Start menu.

Show installation steps

i TactileView 2, 2, 0, 0

TactileView 2, 2, 0, 0

Publisher: Thinkable
Web site: wrwy tactileview .com
Email address: info@Etactileview.com

InstallMate will install or upgrade TactileView an your camputer,

Click Mext to continue,

oy Copyright (C) 2015 Thinkable
\\f ‘ This program is protected by copyright law and international
.&; treaties. Unautharized reproduction or distribution of this

k i ) program, or any portion of it, is a violation of applicable laws.

About. .. < Back Cancel

Sep 1: Software details. Click 'Next' to proceed.
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i TactileView 2, 2,0, 0
Installation options —
&
These options deteming how the application will be installed. |§i
[F]

- ] TactileView o o

.. [] Older Fes {mostly Dutch) This installs TactileWiew
Option size: 31,855 KB
Inztall size: 31,355 KB
Remave size: 0 kKB
Disk space: 302,286,236 KB

Installation folder:

C:'\Program Files (&) {Tactileview Browse...

< Back Cancel

Sep 2: Installation options. Select the folder in which TactileView will beinstalled if necessary and click
'Install' to proceed.
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i TactileView 2,2, 0,0

Operation in progress "‘"-'-;'
Flease wait while TactileView iz being processed. hi‘l

Waiting for the uninstallation to finish___

InstallMate®
< Badk Mext =

Sep 3: TactileView installation. Thiswill be completed automatically.
i TactileView 2, 2,0, 0
Installation completed

TactileView has been successfully installed on your computer,

[T Start the application (disabled)

Click Finish to dose InstallMate,

Cancel

< Back
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Sep 4: Installation has finished. Click 'Finish' to close the installer.

First launch

During the first launch you will be asked to select your user language. Select your language from the list,
then click 'OK" to confirm. Please keep in mind that a number of these user languages have been
automatically translated and might not be completely correct.

Show language selection

Set User Language

Cedka 0K

Dangk I_—I

Deutsch Cancel

ErE —

Espariol

Francais

ttaliano

Mederdands

Morsk

Polski

Portugués

Pycchuid AskK

Svenska

Turk

G =l {Arabic)
=l (Hindi)

o 08

‘:EE [Chinase)
H#:E

Set user language when launching TactileView for the first time.

Configuration wizard

8/187



TactileView software manual
Visit us at http://thinkable.nl

TactileView will now open and prompt you with the Configuration Wizard, which will guide you through
registration and the most important settings for optimal use of the software. Each of the 4 stepsin the
configuration wizard are 'Computer registration’, 'Printer setup’, 'Configuration’ and 'External software'’. In
each step, there isalist with the essential settings. By selecting one from thislist, you can read the
description on the right. Click on 'Open selected option' to go to the selected settings dial og.

Show configuration wizard steps

Welcome to TactileView

You are using the TactileView design and production saftware with version number: 2, 200,

Default values might have changed or new features could have been added to the software. We advise you to take a moment
to follow this configuration wizard or review the individual options in the Settings menu.

These four steps in configuration wizard will help you to use the TactileView software to its full extent:

1. Computer registration; With yvour software product code (5PC), the computer on which the software will be used is
registered on the TactileView website. You will also be asked to enter or confirm your contact details.

2. Printer setup; The installation and preparation of a printer or braille embosser for your computer.

3. Configuration; Selection of the optimal software settings to suit your personal use.

4, External software; Extend the functionality of TactileView by combining it with external software.

By skipping this configuration wizard, you will continue to the demonstration mode of the software. You can revisit the

configuration wizard via the Help menu to guide you through the steps again. The individual options for optimal use of the
software can also be found in the Settings menu.

| Start configuration wizard | Skip configuration wizard

Configuration wizard: Introduction. This window gives an overview of the different stepsin the
configuration wizard. Click on 'Start configuration wizard' to proceed.
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Step 1/4: Computer Registration

With your Software Product Code (SPC) you can register the computer an which the software will run on the TactileView website, This
SPC is valid for one computer and can be found in your licence document or in the email that you received. Please keep your SPC for use
in future updates,

The registration is valid for all users on this computer if you have administrator rights during registration, Otherwise the registration
needs to be repeated with the same SPC for other users,

Without registration, TactileView runs as a demonstration version with full drawing functionality, However, designs cannot be saved or
copied and will contain watermarks on prints.

Registration via internet Description
Registration via distributor Register the software on the TactieView website with your
name and SPC.

| Open selected option | Previous Mext Cancel

Configuration wizard step 1/4: Computer registration. In this step, you can register your software licence.

Step 2/4: Printer setup

To produce the designs that you have created, you can either print them on an ardinary printer using micro capsule paper (swellpaper) or
on & braille embosser.

Some braille embossers (e.g. Index V4 and ViewPlus) have their own drivers that need to be installed with the supplied installer. The
printer can then be selected from the list via Print Setup. For other printers that do not supply their own drivers, choose 'Install Braille
Printer' to select one of the drivers developed by TactileView.

For spedific driver and installation details we refer you to the documentation of the printer or the supplier's website,

Description

Insﬁ‘?" Br.;illle Printer First install the driver that comes with your printer or
_?_raltel -Il;al ES tation: int embosser using the supplied installer. Once the driver has
Extlahel presentation: on prin been installed, you can then select the printer or embosser

fram this list and configure the printer settings.

| Open selected option | Previous Mext Cancel

Configuration wizard step 2/4: Printer setup. This second step will help you to configure the steps
required for printing your tactile designs.
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Step 3/4: Configuration

We strongly recommend you to take some time to check the various settings. An optimal configuration will give you the best possible user

experience. Also be aware that some of the settings will affect the tactile readability of the desings that you create. For the usage and
configuration of extra hardware or changes later on, visit the options in menu Settings.

|  Desaipton

#’i?(?cT:I:?;Spresen tation: on screen Select the units of measurement and other general settings
' for optimal use of the software.

Update TactieView Components =

Sign up for Mewsletter

| Open selected option | Previous Mext

Cancel

Configuration wizard step 3/4: Configuration. All basic settings for operating the software are included in
this third step.

Step 4/4: External software

The functionality of the TactileView software can be extended even further by incorporating third party software, This software might
already be installed on your computer, otherwise we refer you to the supplier of the software.,

Insert TactileView Design in Text File Description
Mathematical notation (equation editor) Duxbury Braille Tranelator (DET) is a braille editor and
translator for text. Designs made in TactileView can be
induded in DET documents, allowing you to create combined
text and graphics docurments.

| Open selected option | Previous Finish

Configuration wizard step 4/4: External software. Thisfinal step will help you to extend the functionality
of TactileView with external software.
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1.04 Updates and beta versions

A new version of the TactileView softwareis released periodically. Y ou will automatically be notified by
email when anew release is available for downloading. The Release notes section will give you an
overview of the new software features and bug fixes that are included in each of the public release
versions.

Y ou can simply launch the downloaded software installer to update your TactileView installation (you do
not need to uninstall the previously installed version). The same applies to development versions that are
not publicly available.

When you launch TactileView after installation, you will be asked to verify your contact details. The
configuration wizard will then open. We recommend to have alook at the steps in the wizard, as some
settings might have been added or changed.

13/187



TactileView softwar e manual
Visit us at http://thinkable.nl

1.05 Transfer installation or uninstall TactileView

The software product code (SPC) allows the software to run on one computer. In case you need to have
the software running in full version on another computer as well, an extra SPC is required.

Visit our shop to purchase an extra software licence.

Reinstalling on another computer

Y ou might want to transfer the software installation to a different computer, using the same SPC. By
sending us an e-mail, we can delete the currently registered computer data, allowing the SPC to be

reinstalled on another system. An e-mail confirmation is sent to the mail address that was entered in the
registration form.

Uninstall TactileView

If you wish to uninstall the software from the current computer, open the Control Panel, click 'Programs),
then select 'Programs and Features. Select TactileView from the list and click 'Uninstall’.
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1.06 Troubleshooting

TactileView software has been around for over a decade and is completely safe in use, but due to the
limited number of users, some virus scanners, web browsers or Windows may automatically block
TactileView. Here are afew ways to solve the most common problems when downloading and installing
the software.

Downloading the softwar e - browsers

Some browsers might block a downloaded file when it is not downloaded regularly.

Google Chrome

After downloading TactileView, Google Chrome might block launching the downloaded file.

Keep

Learn mare

TactileViewlnstall220....exe is not commonly

Discard
downloaded and could be dangerous.

Thisis encountered mostly with new releases or development versions of TactileView. Click on the small
arrow on the right to show more options, then choose 'K eep' to dismiss this message.

Internet Explorer

When the security level in Internet Explorer is set to 'High', a message will appear when you download
TactileView.

Security Alert

! . Your current security settings do not allow this file to be downloaded,

........................................
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To solvethis, click on the gear icon in the top right corner and go to Internet Options. In the Security tab,
reduce the security level to 'Medium-high'. Y ou can now retry to download the software installer. Next,
choose to save or run the TactileView installer.

Other browsers

In case another web browser blocks your downloaded file, check the security settings of the browser or
any virus scanner add-ons. If these are too strict, try to lower the security level and retry to download the
file.

Installing the software

Windows SmartScreen

Windows protected your PC

Windows Smartscreen prevented an unrecognised application from starting. Running this application might
put your PC at risk.

Windows SmartScreen will often block when the TactileView installer is launched for the first time.
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Windows protected your PC

Windows Smartscreen prevented an unrecognised application from starting. Running this application might
put your PC at risk.

Publisher:  Unknown Publisher
Application: TactileViewlnstall2200.exe

| Run anyway |
3

To continue with the installation, click on 'More info', then select 'Run anyway'.

Virus scanners

Aswith browsers, the security level of your virus scanner will determine whether launching TactileView
will be allowed. Lowering the security level will usually solve the problem. The example below shows
how to resolve the problem when a lower security level will still block TactileView. In this example AVG
is shown, but other virus scanners will provide similar options.
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- ot
" AVG. AntiVirus FREE B Joinus on Facebook | Reports 7 | Support

Scan computer

Scan selected folder...

Scan file...

Update

Update from directory...

Histary 4

‘ Virus Vault
17}

Advanced settings... h
Computer Web Identity Help contents
PROTECTED PROTECTED PROTECTED

Get support

Your AVG Web
@ Scan now {:» Fix performance 0 About Wiruses and Threats

Buy now
Activate
Register AVG AntiVirus Free Edition 2015

MyAccount

Premium Support

MEKImIZE your protectlon with PRO. Abaut AVG
nhanced Firewall An am, Da fe a

1. Go to 'Options and select 'Advanced settings.
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% {AVG AntiVirus FREE Advanced Settings

Appearance
Sounds Exceptions
Temporarily Disable AVG Protection * Dbject
B Computer Protection
= AntiVirus
Expert Settings
Anti-Rootkit
Cache Server
Email Protection
B Web Browsing Protection
LinkScanner Surf-Shield
Identity Protection
Scans
Schedules
Update
Virus Vault
AVG Self Protection

e — < I |

Ignore Error Status

Advisor - Known Networks Add exception

Used by Component

®

2. From the list of options, select 'Exceptions and click on 'Add exception'.
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= |AVG. AntiVirus FREE

Exception type:

éSeLect exception type

3. Select "Application or File' as Exception type.
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= |AVG. AntiVirus FREE

Exception type:
Application or File

Choose the file you do NOT want to be scanned

C:\Program Files [x8&)\TactileView\TactileV.exe

Ignore this file:

z

Use this exception for:
Resident Shield [if checked, AVG will NOT scan the file or app when opened)
Manual and Scheduled Scan (if checked, AVG will NOT scan this file during scans)

Identity Protection [if checked, AVG will NOT monitor the app for malicious behavior]

4. Inthelist of options that appears, browse to the location of the TactileView executable file; by default
thiswill be C:\Program Files (x86)\TactileView\TactileV .exe. Check 'Even when the file has been
changed or updated' to avoid having to repeat this process after a software update. Click '‘OK" to confirm.
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% {AVG AntiVirus FREE Advanced Settings

Appearance .
Sounds Exceptions

Temporarily Disable AVG Protection * Object Type Used by Component Da
Computer Protection
Email Protection
Web Browsing Protection
Identity Protection
Scans
Schedules
Update
Virus Vault
AVG Self Protection
Privacy Preferences

<any content>C:\P...\TactileV.exe Application or... Resident Shield, ldentity ... 24

Ignore Error Status
Advisor - Known Networks

Add exception Remove Remove all

5. You will now see TactileView in the list of exceptions. Y ou need administrator rights to confirm the
changes by clicking 'OK".
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2.01 Softwar e product code (softwar e licence)

To run the software in full version, a software product code (SPC) is required. This SPC is provided by
your dealer or has been sent by email after you purchased a software licence in the Thinkable shop.

Click hereto purchase alicence for TactileView.
Softwar e registration

Y ou can follow the configuration wizard to register your software licence. Thiswill start automatically
after launching TactileView thefirst time. If you wish to register at alater stage, you can select the
configuration wizard from the Help menu, or select ‘Computer registration’ from the Settings menu.

Step 1 of the configuration wizard will guide you through the software registration. Choose 'Registration
viainternet' to register the software online with your SPC. When the computer on which you want to
register the software does not have internet access, you can choose 'Registration viadealer'. After
registration, the other three steps in the configuration wizard will help you to prepare and personalize the
software for optimal use.

Registration viainternet

In the dialog that appears, enter your name and SPC, then click on OK. Y our name and SPC, along with
the computer identification code, will be stored on the TactileView website to complete the registration.
An SPC can be used to register TactileView on one computer only. Y ou will need administrator rights to
register the software for all users on the computer.
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2.02 Using the free demonstration mode

For afreetrial version of the software, you can ssmply download TactileView for free and install it on
your computer (requires administrator rights). This allows you to use the software in demonstration mode
without registration and to explore the great features in the software for creating tactile graphics. In
demonstration mode, all software features are available. The only restrictions will be that printed designs
will contain watermarks and files cannot be saved.

To download the free trial version of TactileView, click here.

Configuration for demonstration mode

After launching the software for the first time, the configuration wizard will automatically guide you
through the most important settings. To start using TactileView in demonstration mode, you can skip step
1 of 4in the wizard. We strongly advise you to take the time to go through the remaining three steps,
which present you with the settings that will give you the optimal user experience. Y ou can revisit these
and other setting via the Settings menu.

Read more about the Configuration wizard >
Upgrading to a full software version

After having played with the software, we hope you like it so much so you will contact one of our dealers
or buy your licence in the Thinkable shop.
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2.03 Settings menu

Settings
Computer Registration (TactileView is registered)
General
Languages
Braille Tables
Sign up for Mewsletter
Update TactileView Components

Text label presentation: on screen
Text label presentation: on print

Line view/dot view

Mathemnatical notation (equation editor)

Insert TactileVYiew Design in Text File

Figures

Speech

TactileView Digital Pen
Scanner

Webcam

Microphone

Touch Tablet

Production Requests (Remote Printer)

The configuration wizard leads you through the initial steps for setting up the software to accommodate
your needs. However, additional options/dialogs can be found in the Settings menu. In this main menu, all
the different settings of the software can be found, including those that are part of the configuration
wizard.

Most option names will probably speak for themselves. Each settings dialog has an explanatory
introduction that will help to select the best setup for you. The list below gives an overview of the
functionality of each option in the Settings menu and provides a general description of the purpose for the
menu items.

Computer registration

The software product code (SPC) has to be entered in the registration window. After selecting
‘Registration viainternet’, your registration data will be checked on the TactileView website to verify
the validity of the registration. Please note that each SPC isvalid for only one computer.

Configuration wizard: step 1
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General

The units for the preferred measurement system can be set, as well as the reference position for these
measurements. The size of the markers that can be ‘ grabbed’ with the mouse to modify objects can be
adjusted. A marker size of 5 pixelsis the default.

Theinternet gateway to the TactileView internet catalog can be tested and configured. The name and e-
mail address of the author that is uploading designs to the catalog can be entered here. The TactileView
Viewmaster will send feedback on the graphic aspects and tactile usability of the designs to this e-mail
address.

Configuration wizard: step 3

L anguages

The user language in which the software texts are displayed can be set, as well as the language in which
the text labels are written in the design. Setting the text label correct language isimportant for uploading
the designsto the catalog, astext labels are trandlated in al the available languages.

Configuration wizard: step 3

Brailletables

The conventions for texts in braille differ per country or language. Select a braille table as the main braille
from the extended list of the Liblouis set of tables (includes contracted braille). When entering a text label
in the design with the drawing tool 'Add text label’, the braille characters will be automatically generated
according to the selected braille table.

Configuration wizard: step 2

Sign up for newdletter

The Thinkable newsletter is aresource in which we announce events and share ideas about the usage of
TactileView and various other products by Thinkable. Our regular newsletter isa great way to stay in
touch with our work and everything that's going on at Thinkable, so we invite you to sign up and leave
your feedback.

Configuration wizard: step 3

Update TactileView components

Technically the software is set up as amodular system. The various modules, such as the software texts
that you find in menus and dialogs, are stored and maintained on a non-public section of the TactileView
website. TactileView will download any new updates automatically each time the software is launched.

This setup offers great flexibility and convenience to provide minor updates without requiring any action,
so it isadvised to have this setting switched on. Please note that an internet connection is required to
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receive updates.

Configuration wizard: step 3

Text label presentation: on screen

The appearance of braille is quite different from the standard font and is hard to read for sighted users.
Therefore the text that is added as atext label in the design can be displayed in standard font aswell asin
the equivalent braille characters, based on the selected braille table. The colour of the standard font
(default green) can be changed or can be switched off completely.

Configuration wizard: step 3

Text label presentation: on print

Text labels printed on swellpaper can be represented both in braille and standard font, similar to the
display on screen. The braille dots are printed in black. The visual font can be switched off or set to any
preferred colour. For printing on swellpaper, make sure that the selected colour has no grey or black
appearance.

Configuration wizard: step 2

Lineview/dot View

Depending on the selected embosser type, the positioning and distance between the braille dots will vary.
During the design phase it might be easier to work with continuous lines. For a close check of the tactile
layout it can be useful to switch to dot view. While switching from one mode to the other an explanatory
message will be displayed.

Mathematical notation (equation editor)

The MathType equation editor can be used to prepare mathematical equations in their spatial layout. The
mathML expression is copied/pasted into TactileView. The equation can be expressed in braille using
several mathematical notations. The preferred math notation is selected here.

Configuration wizard: step 4

Insert TactileView design in text file

TactileView designs can be embedded in documents that are produced with the Duxbury Braille
Trandlator (DBT) See for more details al so the section thirdparty software.

Configuration wizard: step 4

Figures

271187



TactileView softwar e manual
Visit us at http://thinkable.nl

Arrows, electrical or chemical symbols, smileys, etc. can be added to the design as afigure by selecting
the drawing tool *Add Figure'. A library of figuresisincluded, but new categories or figures can be
added. In this settings dialog you can set the folder for your personal library of figures.

Speech
The Text-to-Speech engine (TTYS) is selected in this dialog and performs two tasks.

The TTS vocalizes the software messages to support the use of a screen reader and is announcing the text
that is supplied in the audio style for an object.

A design, once embossed, is called tactile diagram. In addition to the tactile information, an extralayer of
audio information can be added to the design. Specific areas can be provided with an audio style (See dso
common properties of objects). The TTSis used for when exploring the audible information in adiagram.

TactileView digital pen

The TactileView digital pen acts as a connection between the software and the TactiPad drawing board or
the TactileView ClickPad. For both setups, the software is providing additional functionality in
combination with the hardware. Attention has to be payed to the position of the receiver and the
calibration. The usage for this setup is targeted for visually impaired users of the digital pen and requires
ahigh skill level.

See also the sections TactileView digital pen, TactiPad and ClickPad

Scanner

When a scanner is connected to the computer, it can be configured in this settings dialog. Select the
option 'Quick scan with scanner' from the Portal menu or click on the scanner icon in the top toolbar to
start the scanning process and insert the scan in the existing design or in a new document. For further
processing use the drawing tools from the drawings toolsicon bar.

Webcam

When the computer is equipped with a built-in webcam or an external one, select 'Activate webcam' from
the Portal menu or click on the 'Activate webcam' icon in the top toolbar to start the webcam. The
resulting image can be inserted in the existing design or in a new document. For further processing use
the drawing tools from the drawings tools icon bar.

Microphone

The built in microphone or an external one can be configured for adding recordings as an audio style to an
object. See: Common properties of objects.

Touch tablet
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A touch tablet can be connected to explore audio tactile diagrams. The settings are configured in this
settings dialog. See also the section * Audio tactile diagrams'.

Production requests (remote printer)

Not everyone has access to a production facility (swellpaper or braille embosser) for tactile graphics. In
combination with the TactileView website, printers can be made accessible for remote printing by other
users. This feature requires a software and printer installation that is made available to others as a so-
called production facility.

To upload your production requests to a remote printer, a customer code and teleprint code are required to
keep track of which design has to be produced on which embosser for which customer.

For the production facility, a customer code and an printer identification code are required to retrieve the
production requests from the TactileView website.
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3.01 Softwar e window e ements

After launching TactileView, the software window will contain the following sections that provide al
available functionality and allow you to operate al the functions in the software.

Drawing area

In the centre of the TactileView window you can find the drawing area of the design. The drawing areais
surrounded with ared border, indicating the size of the printable area on the selected paper size for the
selected printer. Some printers have larger margins along the edges of the paper that cannot be printed,
resulting in asmaller areawithin the red border compared to other printers.

The white area shows the actual size of the contents of your design. The size of the contents can be
increased in size both horizontally and vertically to span multiple pages. If the white area does not fit
within the red border of the printable area, you can reduce the size to make it fit within the page(s).

All software functions are situated around this drawing area.
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Figure 1. Drawing area highlighted in green.
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Top section: menus and horizontal icon bars

Above the drawing area, you can find three elements: the software menus, two horizontal icon bars and
the names of the opened documents. The top row of icons are general functions for the software, whereas
the second row contains functions related to the design that you are working on in the drawing area. In
some icons, asmall arrow indicates that there is a dropdown toolbar with additional options. Most icons
will depict the function that they represent. To get more information, your can hover over the icon with
the mouse. Tooltipsin your selected language will be displayed, explaining which function will be
activated when you click on the icon.
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Figure 2. Menus and horizontal icon bars highlighted in green.

L eft section: vertical icon bars
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On the left hand side you can find two vertical icon bars. The leftmost vertical icon bar contains al the
drawing tools to create graphics or modify the content of your design. By selecting one of these tools and
clicking in the drawing area, different objects can be placed.

Theright vertical icon bar will show the range of properties for the current selection. This can either be
the drawing tool selected from the left toolbar, or the object in the design that has the focus. Y ou can
(re)select an object by clicking on it in the design area.

Once again, tooltips will explain which functions are represented by the icons in the vertical toolbars.
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Figure 3. Vertical icon bars highlighted in green.

Bottom section: statusline

Below the drawing area you will find the status line, showing mouse position, dimensions, etc. for the
selected drawing tool or object in the design.
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Figure 4. Drawing area highlighted in green.
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id=utxb8HktCS4& HD=1","div_utxb8HktC4", "640", "510", "8", null, null, parameters, attributen);
yt_actie(" utxb8HKktCS4, 'init™);
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3.02 After launching the software

In this section you can find afirst introduction to some of the first software functions you will come
across when you create atactile design.

First impression
After launching the software, the red border is showing the current paper size and orientation.

The word 'Title' can be found in the top left corner. Thisis to make you aware of the importance of atitle
in your design, which will help the reader to understand the content of the diagram at hand.

When you open a new design, you will see atactile marker in the upper right corner. This so-called right-
up marker helps ablind reader to easily find out the paper orientation without having to explore its
contents first. Thisthe position of the right-up marker is always in the top right corner, independent of
landscape or portrait orientation. On screen, the marker is shown as three blue lines at an angle of 45
degrees.

For most designs we advise you to include the right-up marker for ease of use. However, by clicking on
the marker it can be turned off, which for example can be used if you want to print multiple designsin a
bundle and bind them. A red marker will remain which can be activated to switch the marker on again.

Xl
-
-
»-
11
(it ]

Figure 1. The top of the design shows the title text label, right-up marker and red border for paper size
and orientation.

Design orientation: landscape or portrait designs

Choosing the right paper orientation for your design allows you to make optimal use of the available
space on the paper. This way the image can be presented as large as possible in order to retain smaller
details. Y ou can change the paper orientation by clicking on the 'Change the orientation to
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landscape/portrait’ icon in the design toolbar (second vertical toolbar when nothing is selected). Y ou can
also find this option in the Design menu.

It isimportant to know that changing the paper orientation will not adjust the size of theimage! This
ensures that the tactile quality of the image is maintained. However, you might need to adjust the width
and/or height manually to fit the new paper orientation by dragging the markers around the design.

Y

'Change the orientation to landscape' icon:

'‘Change the orientation to portrait' icon: é'l

Portrait to landscape orientation

When you start with a design with atree in portrait mode and you decide you want to haveit in
landscape, you can change the paper orientation. The size of the white design area that contains the tree
will stay the same.

Itislikely that the lower part of your design will now be outside the red border and that you have two
sheets of paper instead of one. Even though you could have a design spread over multiple sheets, chances
are you would want to reduce the design size to fit a single sheet of paper. Y ou can use the blue marker in
the lower right corner to make the height of the tree fit. Please note that your tree has become smaller, so
make sure any smaller details are still adequate for tactile use. Next, use the purple marker in the middle
of the right side of your design to add paper to span the width of the paper.

Landscapeto portrait orientation
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The other way around, you might start with atree that spans the height of adesign in landscape
orientation, but decide you want it to be in portrait to make better use of the length of the paper. In that
case, you could increase the size of the image by using the blue marker in the lower right corner. Y ou can
use the purple markersin the middle of the two sides of the white areato trim any empty space left and
right of the tree.

For more information, see section 'Paper size vs. design Size'.

Lineview and Dot view

To get you familiar as soon as possible with the effect of creating designs for braille embossers, you can
view the design on screen asit will be embossed in dots.

For good visibility you can use the line view mode for the drawing. When you switch to dot view, all
lines will be converted to individual dots, just as your braille embosser will do.

Y ou can read more in the section 'Design mode: dot view/line view'.
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Figure 2. A circle shown in line view (left) or dot view (right) shows the graphic capabilities of the
selected embosser.
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3.03 Colourson screen
General colour usein TactileView

. Green

The colour green is used as a colour for information. Everything you see in this colour is NOT printed on
the design. Examples are: the font 'beneath’ the braille dots of the textlabels, the alignment lines for the
text labels, the grid for aligning object in the drawing area, the letters at the angles for the triangle.

. Blue

Objects created with one of the drawing tools (square, line, circle, dot, etc.) are presented in blue.
Variations of blue are used to indicated the selected dot height (for embossers that support varying dot
heights). A lighter blue colour indicates alower dot height.

. Black

Linesthat are created with the drawing tool 'Retouching: Adding lines, are drawn in black. Thisindicates
that the lineis part of the underlying bitmap in the design. The bitmap consists of individual pixels that
can be erased by choosing 'Retouching: Erase'.

Any colours present in images inserted from file or from the internet will be converted to braille dots.

These images should be processed using the filters and be converted to black/white in order to print them
in braille lines.

@ Purple
Markers are placed on or around a selected object. These markers can be used to reposition or resize the

object, or change its proportions. Markers with a different function will have a different colour instead of
purple.

® R

A red border is surrounding the drawing area, reflecting the printable area of a sheet of paper in the
selected paper size. When the designs exceeds thisinitia area, the red borders will signify that multiple
sheets of paper will be printed that together will contain the design.

Special cases

Text labels

A rounded marker precedes each text label to signify the type of input used for the specific label.

@ Green is used for text labels entered with the regular computer keyboard,;
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Orange for those that were created with Perkins style input;
Grey/blue for mathematical textlabels, created with the MathType equation editor.

Formulasin graphs
When multiple formulas are used in agraph, each formulain a graph will have its own colour (red, green,

blue and yellow) to easily distinguish between them. These different colours are only used for display on
the screen and will not lead to differences on a print.
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Figure 1. Colours are used on screen to distinguish between different formulas.

Braille tables

In asingle document, multiple braille tables can be used to accommodate for language variations. In the
design toolbar (right vertical toolbar when nothing is selected), click 'Show used braille tables to see an
overview of the different braille tables in the design. Colours are used in the legend and design to
distinguish the different braille tables.
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rmain table DUTCH2005 (1)

en-us-gl.cth (1]
de-de-gl.cth (1)
Es-Es-gl.uth (1)
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Figure 2. The coloursin the legend and text labels signify the used braille tables.

Audio styles

Objects with audiostyles are presented with alight red/pink fill.
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Figure 3. The light red colour signifies that the circle contains an audio style.
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3.04 Portrait or landscape design

For tactile graphics, the image size has a big influence on tactile usability. TactileView provides several
optionsto control both design and paper size for optimal tactile quality.

Be aware that changes in paper orientation and scaling the design may unintentionally cause the edges of
the design to extend beyond the size of one sheet of paper.
See also: Paper size vs. design size.

Amount of detailsin atactile diagram

On one hand, the level of detail that can be presented in atactile graphic is limited due the discriminatory
capabilities of the fingertips. On the other hand, the relatively large size of braille dots and the minimal
required distance in between dots also limit how much detail can be included.

The larger the design, the more detail can be retained when printed with an embosser. Thiswill help to
control the complexity of the designs.

L ]
® Fern | eaves

noo,

i
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Figure 1. Thisimage shows the shape of a fern branch, but might not contain sufficient tactile detail in
the leaves. A separate image could be used to display leaf details.

Images aslarge as possible
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Although there is alimitation to the size of animage, it is best practice to use as much of the paper as
possible. Matching the design orientation to the dimensions of the tactile graphic (i.e. using landscape for
wide images and portrait for higher ones) allows for optimal positioning on the paper. Rotating from
landscape to portrait or vice versa may give a 30% larger image, which greatly improves the tactile
usability.
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Figure 2. By choosing the right orientation, the image can be shown larger, maintaining more detail.

When changing the design orientation, the image will not automatically be scaled. Thisway, as a designer
you have full control to determine the ideal dimensions of the tactile diagram.

Try to think about the optimal size of the tactile diagram before starting the design: a higher level of

detail will require alarger design size. Adjustmentsin size can always be made later by scaling the design
with the purple markers around the edge. However, text labels have a fixed size. By scaling the image
they might overlap lines or may end up too far from the elements in the drawing that they refer to.

Multiple sheets of paper

The maximum size of paper that printers generally can handleis A4, A3, US Letter or Tabloid. However,
diagrams can be larger than the maximum paper size when an image needs to be enlarged to retain the
level of detail in the original image. Multiple sheets can be placed in rows and or columns to alow for
tactile diagrams of any large size. The red paper border will indicate the size of the design and the number
of sheets.
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3.05 Scroll whedl and key combinations

A number of software features are easily accessible by using the scroll wheel when operating the software
with your mouse. The description below gives an overview of the different operations using the scroll
wheel for better efficiency when drawing.

Operation Shortcut

Pan vertically through design Scroll up/down

Zoomin Ctrl + scroll up

Zoom out Ctrl + scroll down

Rotate selected object 5 degrees Shift + scroll up/down
Rotate selected object 1 degree Shift + alt + scroll up/down
Increase/decrease line thickness Shift + scroll up/down
Increase dot size Shift + scroll up/down

Pan vertically through the design (Scroll up/down)

When the mouse is in the design area, scrolling up or down with the mouse wheel (no keys pressed) will
allow you to move vertically through the design.

Zooming in/out (Ctrl + scroll up/down)

To view aparticular part of the design in more detail, you can zoom in by using Ctrl + scroll up. Ctrl +
scroll down will zoom out in order to view alarger section of the design.

Rotation of objects (Shift + scroll, Shift + Ctrl + scroll)

Almost all objects (including textlabels) can be rotated any number of degrees. The angle for the rotation
can be set in an edit field by clicking 'Rotation’ in the object's toolbar. For easy access, a selected object
can be rotated in steps of 5 degrees by using Shift + scroll wheel up/down. For more accuracy, Ctrl + shift
+ scroll up/down will rotate the object in steps of 1 degree.

I ncrease/decr ease of line thickness or dot size (Shift + scroll up/down)

The value for the line thickness, the eraser width or the size of the blue dots can be set by entering avaue
in the respective dialogs. While drawing, the size can be easily adjusted Shift + scroll wheel.
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3.06 Layout tools

In TactileView, several tools are available to facilitate a precise design process and cope with regulations
and conventions that specify the layout of atactile diagram.

Right-up marker

Once the design is printed and in the hands of the reader, the right-up marker is tactile marker in the top
right corner. This right-up marker helpsto find the correct orientation of the diagram without having to
explore the tactile diagram itself. Thisway you can easily find out if the design should beread in a
portrait or landscape orientation.

When the marker is presented in blue on screen, it will be printed. By clicking on the red marker in the
top right corner of the screen, the right-up marker can be selected or unselected. Alternatively, you can
select 'Draw right-up marker' from the design toolbar (right vertical toolbar when nothing is selected) or
the design context menu.

Figure 1. The right-up marker as shown on screen.

‘Draw right-up marker" icon: ‘j

Alignment grid

A green grid that can be set to preferable cells sizes can help to align all the objects in the design. This
grid will not be printed. Y ou can show or hide the grid and set the cell size by clicking on 'Screen
elements' in the lower horizontal toolbar, then selecting 'Show grid'. This option can also be found in the
View menu.
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Figure 2. The green dotted grid lines can be used for alignment.

'Screen elements' icon: @

‘Show grid' icon: £

Dot view / line view mode
The graphic capabilities for tactile images differ for each individual production medium. Use the 'Design
mode: dot view/line view' to control the layout for the different print outputs.

See: Design mode: dot view/line view

Text label alignment

For accurate placement of texts in your tactile graphics, text labels can be aligned horizontally or
vertically with other labelsin the design. Y ou can select 'Switch text label alignment on/off' from the
properties toolbar of a selected text label, or when placing a new label in the design.

Aslong as the alignment function is on, green 'magnetic’ dotted lines will appear when moving atext
label close to the horizontal or vertical position of another label in the design. The text label on which the
moved label will be aligned will be highlighted. When you let go at this position, the moved label will
automatically 'snap' to this alignment. The same appliesto placing a new text label in your design. Please
note that aligned text labels are not 'connected’ but can still be moved and edited separately.
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Figure 3. Text label alignment with green dotted lines.

Centreobject or text label
All objectsin the toolbar tool have a‘ Centre’ option in their properties toolbar. With this option the

object will move to the centre position of the paper. When the paper width is changed, the object will no
longer be centred.

See: Common properties of objects

'‘Centre icon: @

Move horizontally / vertically
By holding the shift key and dragging a selected object or textlabel, the movement will only bein a

perfectly horizontal or vertical direction.

See: Common properties of objects

'‘Move horizontally/vertically' icon: T"—»
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3.07 Design mode: dot view/line view

The graphic capabilities for tactile images differ for each individual production medium. Swellpaper has
different properties than an embossed image, and each braille printer will differ in dot shape and
placement.

'‘Design mode: dot view' in the second horizontal toolbar is used to display the specific graphic properties
of the selected output medium. With dot view selected, the dots are continuously repositioned to match
the printed outputs as you add to your design. Thisfunctions like a'live print preview' in which you can
directly edit your design and see the final output at the same time.

If you want to see the line drawing that the embossed image is based on or that is printed on swellpaper,
simply go back to 'Design mode: line view'.
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Figure 1. The difference between displaying a design in line view (left) and dot view (right).

48/ 187



TactileView softwar e manual
Visit us at http://thinkable.nl

3.08 Transparency and object stacking

All blue objects with the exception of lines have two components:. the outline (e.g. the tree sides of a
triangle) and the object's surface (the area in between those three lines). The object's surface can be given
a combination of different properties, such as textures and transparency.

The transparency comes into play when two or more objects are (partly) overlapping. When the object is
transparent, all blue parts of the objects 'below’ it will be visible and included on the print. When the
object is not transparent, (parts of) the object below will be covered.

Select 'Change to cover underlying image (is now transparent)' from the properties toolbar or context
menu to make the object non-transparent. Vice versa, select 'Change to make the underlying image visible
(isnow not transparent)' to make the object transparent.

Figure 1. Thecircle on the left is transparent, revealing the square below; the circle on theright is non-
transparent and covers the square.

'‘Make object transparent' icon: m

'‘Make object non-transparent’ icon: u

Control overlap with Object Stacking

By default, the order in which the objects are placed in the design determines the stacking order, i.e.
which object is'on top' and will overlap 'lower' object(s). Objects that were placed later will be on top of
earlier placed objects.
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Y ou can easily get an overview of the stacking order of the objects in your design by selecting 'Screen
elements’ from the second horizontal toolbar, then choosing 'Show object stacking'. When thisis
activated, the object order isindicated with green numbers for transparent objects and orange numbers for
non-transparent objects. The lowest numbers will be on top, e.g. object 1 will cover object 3wheniitis
not transparent.

If you want to reverse the object order, select the object that you wish to move below or on top of another
object, then select "To back' or "To front' to move it below or on top of the other object(s) respectively.

Figure 2. The green and orange numbers show the stacking order of the circles and squares.

'Screen elements' icon: @

i

'Show object stacking' icon:

H

‘To front' icon:

'To back' icon:
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3.09 Bitmap and object drawing

Any design in TactileView contains two layers: one is the underlying bitmap layer, the second contains
the editable objects, figures and text labels that are placed 'on top' of the bitmap. Both layers will be
visible on your prints, i.e. objects do not have to be fused in order to be printed.

Retouching
Y ou can use the retouching tools (pen and eraser) to draw freehand lines or erase elements in the bitmap.

Objects and figures are not affected by the retouching tools and need to be fused with the bitmap first to
(partially) erase them. Y ou can find out more by reading the 'Retouching tools (pen and eraser)' section.

Fusing objectswith the bitmap

Editable objects can be fused to a bitmap at any time. To fuse an object to the bitmap, select it and then
choose the 'Fuse object with bitmap' icon from the second vertival toolbar at the |eft side of the screen, or
right-click it and choose 'Fuse object with bitmap' from the context menu. Y ou can also use Ctrl+B asa
shortcut for fusing an object.

The editing markers (purple and/or red squares around the object) will disappear and the object will turn
black and no longer be editable. The object is now part of the bitmap layer in your design and can be
edited with the retouching tools.

If you accidentally fuse an editable object to the bitmap, you can choose 'Undo’ from the Edit menu, press
Ctrl+Z or click the 'Undo' icon from the tool bar across the top of the screen to undo this action and
retrieve the editable object.

Please note that when you apply one of thefiltersto the entire design, all objects will be fused with the
bitmap. If you want to avoid any objects from no longer being editable, you can also apply afilter locally
on aselected area.

See also: 'Filters; editing an imported image' and 'Selecting area and editing parts of the design'

Converting a selected areato an object

Objects that are part of afused bitmap appear in black, and it is not possible to select them. To convert a
selected areato an editable object, choose the 'Select area icon from the left vertical toolbar, or choose
'Select area from the Drawing Tools menu. Then click and drag the mouse to select arectangular area
around the part of the bitmap you wish to turn into an object.

Oncethe areais selected, it will be surrounded by a black dashed rectangle. Right-click anywhere inside
the selected area and choose 'Convert to figure, or click on the large red marker on one of the sides of the
selection. The selected areais now converted to a figure, which may be edited in the same way as any
other figure object (image).
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See als0:; 'Selecting area and editing parts of the design'
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4.01 The 7 ways of creating a design

In TactileView, there are various ways of creating atactile design, depending on the type of content you
wish to create. For certain types of designs, specialised modules have been included in the software.
All 7 methods described below can be combined whenever needed in your designs.

1. Use premade designs from the TactileView catalog

The TactileView catalog contains thousands of premade designs, ready to be printed and used. Designers
have uploaded the tactually usable designs they created. Y ou can search for a particular design that you
want to use, download it and make modifications needed before you produce them.

Y ou can visit the TactileView designs catalog by selecting 'Download and edit design from catalog' from
the Portal menu, or by clicking on the catalog icon in the top menu bar.

2. Convert images from the inter net

On theinternet you can find an ailmost endless amount of images, many of which are suitable for
production as tactile graphics. For some images only a minimum of effort is needed to adapt the image.
By selecting the right image as a source, such as aline drawing instead of a more complex photo, a
simple combination of applying filters and minimal use of retouching tools can be sufficient.

3. Convert scanner and webcam images

Images taken with a webcam or scanner can be used as a source for atactile graphic. In most cases, the
images that you scan or photograph will need to be processed for tactile use. By combining the filters and
retouching tools, colours can be removed and the image converted to aline drawing. In the settings menu
you can configure the setup for a scanner or webcam for the software.

4. Create a design from scratch

With the series of drawing toolsin the |eft vertical toolbar, a design can be partially or completely drawn
from scratch in ablank design. This method often requires a little more effort than the previous three, but
it gives the most flexibility in case no suitable images are available as a basis for your design.

Most designs require a combination of different drawing tools. The objects (indicated in blue) for
example, give great precision and access to convenient properties such as textures. Text in the correct
braille table can be added anywhere in the design as clarification. Special symbols can easily be added
from the figures library.

5. Create graphs based on an equation

Graphs are widely used in mathematics and many other subjects, but there are alot of factors that
determine the tactile usability of a graph. The mathematics module in TactileView will help you to easily
create a graph based on any given equation. This module can be accessed by selecting the Graphs menu
or the Graphsicon in the | eft toolbar.

6. Create tactile maps

Producing maps of an area of any size (part of acity, region, country or even a continent) can be done
with the map maker modulein TactileView. Select ‘Compose map' from the Portal menu, or click the map
icon in the top toolbar.

The maps are composed on the RouteT actile website by selecting the area you wish to include in the map
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or which features (streets, rivers, buildings, etc.) should be included. Keep in mind that including more
elements will increase the complexity of the map.

7. Combinetext and graphicsin one document

Texts can be included in TactileView documents, but for some purposesit is required to have a document
where the graphics are part of atext book. The graphics can then be inserted in a braille editor such as
Duxbury Braille Translator (DBT).
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4.02 Creating and opening files

TactileView offers anumber of different ways to begin making great tactile materials. Y ou can create a
file from scratch or start from a picture on your computer. Or you could get a head start by beginning
from a pre-installed example file or one of the thousands of designs available in the online catal og.
1.Creating anew file

When you open the TactileView software, a new, blank document is created automatically. Y ou can

begin working in this document immediately. To open another new file, select 'New' from the File menu
or press Ctrl+N. Y ou can also click on the 'Create a new document' icon in the top horizontal toolbar.

Create a new document icon: ‘j

2. Creating a new file by importing a picture
Y ou can create a new document from a picture saved to your computer. To import a picture into
TactileView, select 'Open' from the File menu or press Ctrl+O. In the Open dialog, browse to the location

where your pictureis stored and select it, then choose 'Open'’. A new TactileView document containing
the pictureis created.

=y
Open icon:

3. Opening a pre-installed examplefile

A number of examplefiles are installed with the TactileView software. To open one of these files, select
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the 'Open TactileView Examples option from the File menu. A dialog box will appear with alist of
available sample files. Select afile from the list, then choose the '‘Open’ button to open it in TactileView.

Open TactileView examples icon: L]

4. Downloading and opening a file from the online catalog

To download an existing file from the online catal og, open the Portal menu and choose 'Download and
Edit Design from Catalog'. Thiswill launch a new window that will allow you to browse available files
by category or search for something specific using the search field. Browsing by category is
recommended for best results because of the variety of languages used for file titles and keywords.

Once you' ve chosen a category, select a design and choose the 'Closer Look' link (green arrow button)
beneath it. Thiswill launch aweb browser window with alarger preview of the image in the file. Select
the 'Download & Edit' link.

A dialog will pop up asking if you want to open or save the file. Select 'Open'.

NOTE:

If thisisthe first time you are downloading afile from the TactileView catalog, Windows may open a
dialog box asking what application to use to open the .bpx file. Choose the option that allows you to
browse your computer for the desired application, and browse to C:\Program
Files\TactileView\TactileV.exe on a 32-bit operating system or C:\Program Files
(x86)\TactileView\TactileV.exe on a 64-hit operating system. If there is a checkbox available to always
use this program to open this type of file, make sureit is checked, then select the 'OK" button.

The file will now openin TactileView.

Download and edit design from TactileView Catalog icon: rg
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4.03 Changing design orientation and size

In TactileView, the 'design size' refers to the size of the drawing area, represented on the screen by a
white rectangle. The design size might not always match the paper size and orientation you are using
(indicated by ared rectangle or rectangles on screen), especialy if you are working on a design
downloaded from the catalog or afile created by importing ajpeg or other image file.

By default, when you create a new file, the design areais sized and oriented to match the paper size and
orientation currently set in your print setup. For example, if A4 paper in portrait orientation is set in your
print setup, the design areain new files you create in TactileView will be created with this size and
orientation.

Changing the design orientation

If the design size and orientation are not set to what you want to use, it’s best to change them prior to
beginning to work on the file. To change the orientation of the design area, open the Design menu. If your
design is currently set to portrait orientation, the first item in the menu will be ‘Change Orientation to
Landscape'. If your design is currently set to landscape orientation, the first item in the menu will be
'‘Change Orientation to Portrait'. Select this first menu item to change the orientation of the design. Y ou
can find the same option in the design properties toolbar (right vertical toolbar when no object or drawing
tool is selected).

NOTE:
This option only changes the design orientation; if you wish to change the paper orientation for printing,
you will need to change that separately (please refer to the Printing tutorial).

Resizing the design

The dimensions of the design area can be changed at any time. First, deselect any current drawing tool
(press Esc) or object selection (Esc or by clicking on ablank space in the design ared). Purple markers
will appear around the outside of the design area. The markers adjust only the size of the design area.
Click and drag a marker along the top or bottom edge vertically to increase or decrease the height of the
design area, or click and drag a marker on the left or right edge horizontally to increase or decrease the
width.

The sguare in the lower right corner of the design areais blue. The blue square lets you click and drag to
scale the entire design area and its contents. Thisis useful when you’ ve downloaded afile from the
catalog and it’s not sized to fit the paper you' re using.

Scale design to paper size

When two or more red rectangles are visible, the design will be printed on more than one page. Click and
drag the blue square at the lower right corner of the design area to scale the picture down until it fits on
one page. Y ou can also let TactileView scale the image down to one page for you by choosing 'Scale
Picture to Paper Size Now' from the Edit menu.
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Automatically scale pictures and downloaded designs

To allow TactileView to scale pictures automatically to fit the paper, you can choose 'Scale Pictures
Automatically to Paper Size' from the Edit menu. This option will automatically scale the design area and
picture to fit onto one page of the paper size currently selected in your print setup when you open a
downloaded file or create a new file from ajpeg or other imagefile.

NOTE: When this option is selected, TactileView will also choose the design orientation that best fits the
design area and picture, but it will not change the paper orientation in your print setup. Always ensure
that your paper orientation matches the design orientation before embossing any file. Y ou can verify this
by checking if the design size (white area) and paper size (red borders) match.
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4.04 Importing images from the inter net

Images from the internet often form a great source for atactile image. The amount of different subjects
that can be portrayed is virtually endless. However, selecting the right material from this vast resource
can both improve the tactile quality and minimize the effort needed to convert the image into atactile
diagram.

Under standing which image wor ks best

Virtually any image can be used as a basis for atactile diagram, but some are more suitable than others.
For example, some images are harder to understand when they converted to atactileimage. In general, a
higher level of detail will result in amore difficult tactile diagram. Concepts such as shadows or three-
dimensional perspective can be very hard to understand for a blind reader.

The second consideration is the amount of effort it takes to convert the image to atactually usable design.
Of courseit depends greatly on the type of contents you wish to include in the image, but generally 'less
ismore": asimpler image takes less time to convert than a more detailed one.

An image needs to have enough features that can be understood by touch. This means that images often
need to be simplified by isolating individual lines from the In most cases, line images are preferred asa
basis for adesign.
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Figure 1. The image on the right hasless fine detail and is less complex, making a tactile version easier
to read and taking less effort to edit than the image on the | eft.

Make clever use Google image search
Using Google, you can search for images that match any keywords that you enter. In most cases this will

give thousands of results, so in many cases you will need to refine your search criteria. Y ou could try
searching for a synonym or closely related word (e.g. ‘trees or ‘woods' instead of 'forest’). If you speak
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multiple languages it can be helpful to search for the same concept in another language.

Google aso provides some tools to refine the type of image you are looking for. Y ou can find these by
clicking on the 'Search tools' button. These allow you to make some useful selections for finding the right
material for tactile use. The most important selections for tactile use are:

- Size: larger images are generally better than smaller images, since they provide a better image quality in
which more detail is retained when enlarged. Y ou can aso select 'Show sizes under 'More tools to get a
quick overview of the image sizes.

- Type: refine the type of images that are presented. 'Line drawing' or 'Clip art' both are highly suitable as
abasisfor atactileimage, asthey are often already simplified into individual lines and will be closer to
what isrequired for atactileimage. We aways advise to check first if these types of images are available
to minimize the amount of effort it takes to create a tactile image.

The other search tools, such as colour and time can be used to further refine your search results.
Appropriate usage rights can be selected if it concerns reproduction.

Figure 2. By making use of the Search Tools, you can select line drawings (right) instead of more
complicated images, such as the photo on the left; the line drawing is much easier to read and edit.

Placing theimagein your TactileView design

Once you have found a suitable image, right click on it to open the context menu, then select 'Copy
image'. Thiswill copy the image onto your clipboard. In TactileView, press Ctrl+V to paste theimagein
your design. Thiswill place the image in the design area at the position of you mouse. Y ou can also right
click in an empty area of the design, then select 'Paste’ to place the image on the position of the click. Or
you can select 'Paste’ from the Edit menu or click the 'Paste’ icon in the top horizontal toolbar, which will
place the image in the top left corner of the design.

61/187



TactileView software manual
Visit us at http://thinkable.nl

If you have saved an image on your computer, you can choose ‘Add figure' from the drawing toolsicon
bar, then select 'Import SVG' for svg image or 'Import image from file' for bitmap image (.jpg, .png, ...),
or select 'Import image from file' from the File menu.

Y ou can always resize or move the image to the required position in the design. Use the retouching tools
(pen and eraser), a combination of the filters from the drawing tools toolbar or the Filters menu, or any of
the other drawing tools to make the required adjustments to make the inserted image suitable for tactile
use.

Open link in new tab

Open link in new window
Open link in incognito window
Save link as..

Copy link address

Sawe image as.

Copy image URL

Open Image in new tab

Search Google for this image

Print...

AdBlock

Black element

Inspect element

Figure 3. Copying the image from your web browser.
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4.05 Importing images from file (.svg, .png, .jpg, ...)

Saved images can be used as a basis for your tactile designs. These can be bitmap images (.bmp, .png,
Jpg, etc.) or SVG images. There are two ways to insert these files into your design.

Import image from file

To import abitmap or SVG image file, select ‘Add figure' from the drawing tools toolbar, then choose
'Import SVG' or 'Import image from file' from the context toolbar. A dialog will open in which you can
browse and select the image file that you wish to use. Select ‘imagefiles or 'svg files asthe type of file to
limit the presented files to images suitable for importing. Once you have selected the correct image, click
'‘Open’ to insert the image into your design. The chosen image is now inserted in the top left corner of the
design.

+

'Add figure' icon; =

+

—

L

‘Import SVG' icon:

+

—

i . . IFG
'Import image from file icon: "#i

Copy from Windows File Explorer

In Windows File Explorer, select the image file that you wish to insert in your design. Right click on the
file and select 'Copy', or use the shortcut Ctrl+C. In TactileView, position the mouse where you want to
insert the file and press Ctrl+V to paste the image. Alternatively, you can also select 'Paste’ from the Edit
menu, the top horizontal toolbar or by opening the context menu by right clicking in the design and
selecting 'Paste’.

'Paste’ icon: I—L|
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4.06 Capture scanner or webcam image

Using a scanner or awebcam offers aflexible method to quickly import existing material you're your
design. Both methods create a bitmap image that will need some processing to turn it into atactile usable
design.

Settings menu — Scanner and Webcam

Make sure the devices are configured in the settings menu dialogs 'Webcam' and 'Scanner’. A message
will indicate when your device is not connected or configured when you try to start it.

Scanner

The scanner will create an image (bitmap) of the scanned document. This way, you can use existing
images from text books or documents as a basis for your tactile graphics.

L

'Quick scan with scanner' icon: @

Webcam

The video content from the selected webcam is displayed in a small window beside the drawing area. The
control buttons are available below this window. Y ou can adjust the size of the webcam window by
clicking 'Enlarge/reduce the webcam view'. Pressing the shutter button of the webcam (‘Take webcam
snapshot'’) will record a snapshot image. Y ou can rotate the webcam image if necessary by clicking
'Rotate the webcam view', and shut the webcam window down with '‘Deactivate webcam'.

Existing document or new document

Once you have recorded your scanner or webcam image, you will be asked whether you want to add it to
the existing design or insert it in anewly created design. The image will be placed in the top left corner of
your design. Asthe image isinserted as afigure, the size and position of the image can be adjusted .

Further processing

Aswith all other images (copied from internet or imported from file) further processing is usually
required.
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- Retouching (pen and eraser): fusing the image with the design bitmap allows you to refine parts of the
image.

- Apply filters: colours have to be removed and the image usually has to be converted to aline drawing.
- Use text labels: add atitle and other text labels to clarify the different parts of the image

For afull description of the respective tools, see also the section 'Drawing tools toolbar'.

2

'Activate webcam' icon:
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Figure 1. A separate window shows the webcam is activated for capturing images; click on the image to
enlarge.

Figure 2. Webcam controls: 'Enlarge webcam view', "Take webcam snapshot’, 'Rotate webcam view' and
‘Deactivate webcam'.
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5.01 How to use the drawing toolsicon bar

-9

Do 0O/ SN

*
L

i

The leftmost vertical icon bar offers you a number of tools to add (graphic) objects, modify a selected
areaor apply afilter to the entire design. The tools are clustered into groups of similar drawing tools.
There are two ways of composing your design: by modifying the bitmap and placing objectsin the
design.

Drawing tools: manipulating the bitmap
The retouching tools allow you to draw directly in the bitmap, where the lines you draw have afixed
position. The set of filters allows you to change colours or change the as an exampl e the thickness of lines
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with filters. When you open a saved image file (e.g. a scanned image or an image saved from the internet)
it needs to be fused with the bitmap in order to edit the image.

Drawing tools. placing objects

Thelist of available objects includes lines, squares, circles, triangles and dots, but also more complex
objects such as tables and mathematical grids. These are represented in blue, indicating they are not ‘fused
with the bitmap' and can still be changed whenever you wish.

A special category of tools allows you to add text to the design: text labels, mammoth braille and drawing
letters and digits. These tools will alow adding text in braille or regular font to highlight certain elements
in the design.

Propertiesin second vertical toolbar

Each tool has its own (second) vertical icon bar that will appear when you select a drawing tool or select
the object (again) that was created with the tool. Most objects have some properties in common, such has
position and size, whereas some other functions are specific for the tool or object.

See: 'Common properties of objects
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5.02 Common properties of objects

The drawing tools for placing objects, such as the ‘Draw Square-Rectangle’, allow you to place objects
by clicking and dragging in the drawing area. The blue colour will indicate that an element in the design
is an object. Below, you can find the common properties that are shared by most blue objectsin
TactileView.

Propertiesin right vertical icon bar

As soon as the drawing tool is activated in the left icon bar, or when the object is placed or is selected in
the design, the propertiesicon bar for that selection will appear. For most objects, the first icon in this bar
allows you to determine the size and position by entering the values via edit fields.

'Sze and position' icon: «

Resizing and moving objects

Purple markers can be found on the corners and along the sides of the object. By pulling the markers on
one of the four sides, you can adjust the width or height. For example, a square will become arectangle.
The markersin all four corners will scale the shape, maintaining the same aspect ratio.

Y ou can move objects by holding the left mouse button and dragging it to another position, as indicated
by the four-way arrow cursor. A green line will indicate the distance over which the object has moved.
Two functions in the properties toolbar help you to move an object in a specific way: you can either
choose to horizontally centre it in the design, or only move it horizontally or vertically (alternative: hold
shift while moving the object).
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Figure 1. Resizing a square using the purple markers.

Figure 2. The green line indicates the moved distance when moving an object with the mouse.

'Centre' icon: '@

-

‘Move horizontally or vertically' icon: L)

Rotation

The object can rotate over 360 degrees. Scrolling with the mouse while holding down the Shift key will
rotate per 5 degrees, or use Shift+Ctrl+mouse wheel for more accurate rotation per degree. Y ou can aso
set the rotation to a certain value by choosing the 'Rotation’ icon and entering the angle in the dialog that

appears.

>

'Rotation' icon:

Linestyle

The outer border of the object will be asolid line of a certain (narrow) thickness. The line style will alow
for avariation in pattern, thickness and texture for the border. Choose 'Line style' from the properties
toolbar, then select your style elements from the dialog.
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Figure 3. Squares with different line styles.

‘J

'Line style' icon: **

Surface propertiespart 1. add textureswith Fill style

The Fill style will give you awide variety of textures that add a tactile pattern in to the surface of the
object. The pattern can be selected based on the preview. The patterns are made of repeated tiles. Thetile
Size can be set to determine the fineness of the texture. The pattern can have its own rotation within the
object, independent from the position and rotation of the object. This enables even more variation in
textures, as the same texture can be used in various rotations, giving a different tactile experience.

Figure 4. Squares with different fill styles: no fill style (default) and diagonal lines.

7
'Fill style: texture' icon: é
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Surface propertiespart 2: transparency

The transparency of an object determines whether or not it will cover underlying object. In case the object
istransparent, only the border isvisible. All parts of the design that are overlapped by the object are still
visible.

In case the object is non transparent, al that isinside the object is covered by the white inner surface of
the non-transparent object. Keep in mind that non-transparent objects might (completely) cover other
elementsin the design. Y ou can change the order in which they are presented to determine which oneis
on top of the other.

See also: "Transparency and object stacking'

‘Make object transparent' icon: m

'‘Make object non-transparent' icon: m

Surface propertiespart 3: add coloursfor swellpaper

For production of the design on swellpaper, objects can have a colour as well. Select the desired colour
from the dialog 'Fyll style: Colour'. Keep in mind that most embossers do not support printing in
(coloured) ink, so this function does not apply to production with braille only.

o)

'Fill style: colour' icon:

Audio information

The'Audio style' function is used to add audible information to an object, giving the object an extra'layer’
of information. Thislayer consists of atext that is pronounced by a speech synthesizer (TTS). This
functionality is used to create an audio-tactile diagram and can be explored using the TactileView
ClickPad or TactiPad combined with the TactileView digital pen.
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See also: 'Using audio styles

gi
‘Audio styl€e' icon: I'.

Relief height

Therelief height for the outline, surface and texture of objects can be selected separately. Keep in mind
that this functionality is only available in the properties toolbar when using an embosser that supports
variable dot height.

— [
'Relief height: line, surface and texture' icons: v

Removing objects

Y ou can delete the entire object by selecting 'Delete’ in the properties toolbar or context menu, or by
using the delete key. When you only want to remove parts of an object, you first have to fuse it with the
bitmap. After thisyou can use the eraser tool to remove parts from the object.

'Deleteicon: X

Watch the video to get a quick overview on how to use the drawing tools.
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printHTML ("Lk1sFGytdDQ"); var parameters = { allowScriptAccess: "always' }; var attributen = { id:
"Lk1sFGytdDQ" }; swfobject.embedSWF("http://www.youtube.com/apiplayer?& enabl e sapi=1& playera
piid=Lk1sFGytdDQ&HD=1","div_Lk1sFGytdDQ", "640", "510", "8", null, null, parameters, attributen);
yt_actie("Lk1sFGytdDQ, 'init");
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5.03 Add text labdl

To read atactile diagram with ease, it is often very helpful to add text information to certain parts of the
design. For example the parts of aflower or roomsin abuilding can be labelled in the design.

Text label placement

To place atext label, click on the 'Add text label' icon in the drawing tools, then move the mouse to the
desired position in the design and click again. Y ou can start typing right away or use Ctrl+V to paste a
copied text.

A text label can be positioned anywhere in the design. Leave enough space around texts labels to ensure
the braille dots can be distinguished easily, so make sure that text label are not too close to linesin your
design. Thisway you will maintain optimal tactile usability.

Add Text Label icon: * t

Figure 1. Click in the design to place a text label.

Precise placement: centreor align (snap)

Two functions in the options toolbar allow for more precise placement of text labels. The 'Centre
function will horizontally place the label in the middle of the design.

With "Text label alignment’ turned on, text labels can be aligned with previously placed labels. Green
dotted lines appear in the design when placing or moving alabel close to the vertical or horizontal
position of other |abels. The text label you are adding or moving will then snap to the green line.
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Text label alignment icon:

Centre text label icon: EE
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Figure 2. Text label alignment with green dotted lines.

Text label dimensions: using word wrap

The length of the text is not limited, so text labels can range from just a single number to multiple lines of
text.

Initially the width is set to the maximum paper width. By dragging the sides of the text label you can
determine the maximum width of the text (word wrap). Text that is exceeding the word wrap length is
moved to the next line. The lines of braille text have afixed height that matches the standardised height of
embossed braille text.
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Figure 3. Drag to determine the label's word wrap.
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Text label presentation on screen

Thetext label is presented on screen by a combination of green characters with black dots that represent
the braille characters that will be printed on the braille embosser or on swellpaper. With this setup you are
able to have an eye on the braille characters. Y ou can change how text labels are displayed on screen by
selecting 'Text label presentation: on screen' in the toolbar or via the context menu.

-
4+ E

Text label presentation on screen icon:

Automatically correct braille: brailletables

The guidelines (so-called braille tables) for how texts are displayed in braille differ internationally. By
selecting the correct default braille table via Settings > Braille Tables, the braille in your text labels will
automatically be correct. This means that you do not need to have any knowledge of braille to get
accurate braille in your designs. For example, braille composition signs for capital letters or numbers are
automatically included.

White space behind labels (transpar ency)

By default, labels have a white space behind and around the braille text to ensure that other design
elements do not interfere with the braille. Keep in mind that lines can be covered by the white space if the
label is placed too close.

By switching off the white space (making the label transparent) you are able to place the text label on top
of lines, but make sure they do not disturb the braille.
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Figure 4. Difference in text label transparency.

Typesof text labels

There are three types of text labels based on different input methods for the text. Coloured markers before
the labelsindicate the label type. These are green for keyboard input, orange for Perkins style 8 dot braille
input and blue-grey for mathematical equations. After selecting 'Add text label' from the drawing tools,
you can select the type of text label in the right options toolbar.

Once atext label isplaced in the design it is preceded by around coloured marker. By hovering over the
marker with the mouse, atooltip will show extrainformation about the text label. A marker with awhite
centre indicates the label is transparent.

L
'‘Computer keyboard input' icon: Jane
'Braille keyboard input' icon: bt
Sy
‘Math input' icon: 1=

79/ 187


http://thinkable.nl/different-types-of-text-labels/

TactileView softwar e manual
Visit us at http://thinkable.nl

5.04 Select area; editing partsof the design

The drawing tool 'Select area enables you to manipulate a section of the design. After activating the tool,
two types of functions become available: 'Select Rectangle' (default) and 'Insert or remove space’. The
rectangular selection allows you to make localized adjustments to the contents of your design. Inserting or
removing horizontal/vertical space is used to locally adjust the size of the drawing canvas.

Select rectangle - define the selection

After choosing 'Select area from the drawing toolsicon bar or Drawing tools menu, move the mouse into
the drawing area and click to set the first position of the first corner. Next, move the cursor and click a
second time to complete the selection. Alternatively, you can also click and hold for the first position,
then move the cursor and release at the second position.

A dotted rectangle will indicate which areais selected. This selection can be adjusted by dragging the
purple markers around the selection. To reposition the selection, move the cursor over the rectangle, then
click and hold to drag the selection to another position.

Alternatively, you can select 'Size and position’ from the properties toolbar or context menu to adjust the
selection.

Figure 1. Selecting an area in the design.

Select areaicon:
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Select rectangleicon: 4#

Icons around the selection for easy access

A number of small icons along the edges of the selection give quick accessto afew functions for editing
the selected area.

Mirroring horizontally flips the selected image left to right, like turning a page in a book. Mirroring
vertically flips the image upside down, like turning a page in awall calendar.

Rotation and mirroring the area can be performed by simply clicking on the corresponding icons. The
large red is used to move the selected area of the bitmap, whereas the blue marker allows you to move all
objects and text labels that are (partially) within the selection.

Theright vertical toolbar will show the full list of options for manipulating the selected section of the
design.

Rotate selection icons:

Mirror selection icons;

Red marker for moving the bitmap:

€,

Blue marker for moving objects:

Mowve objects

Move the selected part of the bitrap |
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Manipulate bitmap: crop, make selection white or fuse objects

To isolate the contents of the selected area from the rest of the design, select 'Crop Ared. Only the content
will remain as the design, as the area outside the selection will be removed.

Select 'Paint AreaWhite' to fill the selected part of the bitmap with white. Any objects in the selection
will not be affected and have to be fused first to make them white. Y ou can either fuse all objects within
the selection by selecting 'Fuse the sel ected objects with the bitmap', or fuse objects individually by
selecting and then fusing them.

Crop areaicon: .

' '
......

Paint area white icon:

Edit selected area asfigure (move and resize)

The selected area of the bitmap can be resized and moved by choosing 'Convert to figure (object)’. The
purple markers around this figure can be used to resize the selection.

Y ou can also choose 'Save as figure (file)' to save the figure to reuse it in other designs.

Save asfigure (file) icon:
az

k-3

Convert to figure (object) icon: =2

82/187



TactileView software manual
Visit us at http://thinkable.nl

Apply filters

The selected content can be processed using the range of filters. These have the same functionality asthe
list of filtersin the Filters menu, but will only be applied to the selection instead of the entire design.

See also Filters; editing an imported image (.

Figure 2. Local adjustments by applying a filter to the selected area.

Adding/removing a vertical or horizontal area

The function * Selected strips' can be used to remove the selected vertical or horizontal area, or to add
this amount of white space to the design. To use thistool, activate 'Select area, then 'Insert or remove
space'.

A crosshair cursor will appear when you move the mouse to the drawing area. By clicking once, the first
outline of the selection is positioned, asindicated by the dotted green lines. Next, move the mouse
horizontally or vertically and click a second time to compl ete the selection of the strip. Once again, you
can also click and drag, then release at the second position to define the selection.

The width of the horizontal or vertical selection can be adjusted by dragging the purple marker on the
green dotted lines.

A preview when hovering over the green plus sign will display the addition, whereas hovering over the
red minus sign shows the design with the deleted area. Simply clicking on either sign will confirm the
action.
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Insert or remove space icon:
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5.05 Detect shape

The 'Detect shape' tool is used to add surface properties such as textures to selected parts of the design.

The 'Detect Shape' tool, as the name suggests, detects the shape of an area within the elementsin the
design. Select the 'Detect shape' tool from the left vertical toolbar, then click in the centre of the area
in the design that you wish to edit. A red dotted line will indicate the contours of the detection.

rr

'‘Detect shape' icon:

Fine-tuning the selection

In some cases, the shape detection might need some fine-tuning to get the exact shape you need. Y ou can
use the purple markers to adjust the angular points of the shape, or click on one of the line segmentsto
add another angular point.

In other cases, the detection may not be successful because the areais not fully enclosed by lines or other
parts of the design. Small gaps cause other areas to be linked to the area you wish to detect.

Y ou can compensate for small gaps by choosing 'Change shape detection criteria from the toolbar or
context menu. In the dialog that opens, you can readjust the levels for gap reduction. A higher will result
in less gaps in the shape detection; however the detected shape will aso have slightly more spacing
around it.

Y ou can apply shape detection to coloured images as well. In the detection criteria, you can adjust the
range of colours that will be included in the shape around the detection position.

The detection criteria dialog contains a preview of the detected area, in which white signifies which area
is part of the selection. Once you have adjusted the criteria, click 'Remove contour’, then 'Apply detection’
to improve the detected shape.
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Add properties

When you are satisfied with the detected shape, you can add several propertiesto it, such as textures or an
outline around the shape, just like any of the other (blue) objects.

See: Common object properties
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5.06 Filters; editing an imported image (.jpg, .png, ...)

Images imported into TactileView need to be edited prior to printing using a combination of thefilters
and retouching tools. Because source images vary widely, it is helpful to experiment with the different
filtersto find out what works best for your image. If afilter does not produce the desired result, undo the
action by selecting 'Undo’ from the Edit menu or pressing CTRL+Z.

Y ou can activate one of thefilters by selecting 'Filters icon in the left vertical toolbar, or selecting one
from the Filters menu. For some of the filters, a horizontal slider allows you to adjust the extent in which
itisapplied. Thefilters are applied to the entire design and will fuse all objects in the design.

Y ou can also apply filtersto a selected area only, without affecting the rest of the design; see 'Select area;
editing parts of the design'. Please note: in the images on this page, the filters are only applied to the right-
hand side of the image to show the effect compared to the original image on the | ft.

. . Ty
'Filters icon: E

Convert to linedrawing

One way to process the image so that it can better be embossed is to convert it to aline drawing. Select
the Convert to Line Drawing option from the Filters menu. A slider bar will appear in the upper left
corner of the screen. Drag the dlider left or right until the image looks as desired.
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Figure 1. 'Convert to line drawing' filter.

M
e

'Filter: convert to line drawing' icon: El

Convert to black and white
Some images can come out better when converted to black and white rather than to aline drawing. Select

the Convert to Black and White option from the Filters menu. A slider bar will appear in the upper |eft
corner of the screen. Drag the dlider left or right until the image looks as desired.

LZ N\

Figure 2. 'Convert to black and white' filter.

u‘“u
'Filter: convert to black and white' icon: =

Changelinethickness

Usethisfilter to increase or decrease line thicknesses in the image all at once. If your image contains alot
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of light, thin lines or adark, thick lines, thisfilter is helpful to make them al thicker or thinner at the
same time. Select Change Line Thickness from the Filters menu. When the slider appears at the upper left
corner of the screen, slide it to the right to make lines thicker or to the left to make them thinner.

Figure 3. Thicker lines by applying the line thicknessfilter.

X
'Filter: change line thickness' icon:

Add contours

This option allows you to add outlines around each different colored areain an image. Contours (black
lines) are added at the transition point between one color and another and the thickness of the contour
linesis controlled using the slider that appears at the upper left corner of the screen when you select the
filter. Thisfilter can be helpful for simple drawings that have well-defined areas in distinct colors, but is

less useful when applied to photos or other images where color fades from lighter to darker without a
distinct transition point.
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Figure 4. 'Add contours' adds black contour lines to changes in colour in the image.

F-
'Filter: add contours icon: E

Blur image

The use of thisfilter lets you soften or sharpen edges between areas of color in an image. Select Blur the
Image from the Filters menu, then use the slider that appears at the upper left corner of the screen to
adjust the image. Sliding the slider right will soften edges and dliding it left will sharpen the edges.
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Figure 5. Right-hand side of the image is blurred with the 'Blur image' filter.

.
'Filter: blur image' icon:

Replace colours
Thisfilter is mostly used to remove certain coloursin the image by converting them to white or black. In
the dialog that appears, you can select which colour should be replaced from the list of colours that are

present in the design. Y ou can also adjust the colour range to include similar shades in the colour
replacement. Once you are finished replacing the desired colours, click 'OK' to confirm the changes.

L7 N

Figure 6. Thered colour in the last olympic ring has been replaced by a dark purple colour.

[
'Filter: blur image icon: ¥

Negative

91/187



TactileView softwar e manual
Visit us at http://thinkable.nl

This option is mostly used when an image has alot of black area. Choosing Negative from the Filters
menu will exchange al colors in theimage file with their opposites. Black areas become white, blue areas
become orange, red areas become green, etc.

Figure 7. 'Negative' filter applied to the right-hand side of the image.

H\u
'Filter: negative' icon: B

Rotating, mirroring and scaling theimage

To rotate the entire image, select either 'Rotate Clockwise' or 'Rotate counterclockwise' from the Filters
menu. The image will rotate 90 degrees in the direction you selected.

To mirror the image, select 'Mirror Horizontally' or ‘Mirror Vertically' from the Filters menu. Mirroring
horizontally flips the image left to right, like turning a page in abook. Mirroring vertically flips the image
upside down, like turning apage in awall calendar.

To scale theimage, select it and then drag the blue square in the lower right corner of the design area
diagonally to scale the image smaller or larger.
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'Filter: rotate clockwise/anticlockwise' icons: '/) (\‘

'Filter: mirror horizontally/vertically' icon: #% 4
'Filter: scale design' icon: E
I

'Filter: fuse all objects with bitmap' icon;
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5.07 Retouching tools; pen and eraser
Retouching: adding and erasing lines

All TactileView designs have a bitmap that acts as the 'base layer'. This bitmap layer can be edited using
the retouching tools.

See also: Working with fused bitmaps

Retouching

To draw freehand lines that are automatically part of the bitmap and not editable, select the 'Retouching
Adding lines icon from the toolbar on the left side of the screen, or select 'Retouching: Adding lines from
the Drawing Tools menu. Select the line thickness you would like to use prior to starting to draw by using
the dlider next to the properties toolbar. Y ou can use Shift+scroll wheel for more convenient size
adjustment while drawing in the design. In the properties toolbar or context menu, you can choose
between around or a square pen or eraser shape by selecting 'Apply circular tip' or 'Apply squaretip'.

Y ou can also choose to draw straight or curved lines by choosing 'Use straight lines' or 'Free style (follow
the mouse)'.

Y ou can now use the mouse to draw in the design area. Anything you draw with this tool will
automatically be part of the bitmap and will not be editable unless you select an area containing your
drawing and convert it to afigure or use the 'Detect shape' feature to create an editable object from a
freehand closed shape. The retouching mode will continue until you select another mode or drawing tool,
or until you press the escape key on the keyboard.

4

'Retouching: Adding lines' icon: &

'Line thickness' icon:
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Figure 1. Usethe slider or Shift+ Scroll wheel to adjust the line thickness.

/

'Free style (follow the mouse)' icon: /'

'‘Use straight lines' icon:

4 pixels

+

e >\

Figure 2. Drawing straight or curved lines.

‘Apply circular tip' icon: ‘

'‘Apply squaretip' icon: '

e
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Figure 3. Using a circular or square pen tip.

Eraser

To erase linesin the bitmap, select the 'Retouching: Erase' icon from the tool bar on the left side of the
screen, or select 'Retouching: Erase' from the Drawing Tools menu. The eraser width and shape can be
adjusted in the same way as the line thickness of the pen, aswell as using straight or curved linesand a
circular or square eraser.

Begin erasing by dragging the mouse over the lines you would like to erase. The retouching mode will

continue until you select another mode or drawing tool, or until you press the escape key on the keyboard.
Y ou can only erase any lines fused to the bitmap. Therefore, if you wish to erase a part of a blue object or
inserted image, you will first need to fuse them with the bitmap. Y ou can read more in the manual section

Working with fused bitmaps.

'Retouching: erase' icon: ‘

‘Eraser width' icon: —

/

'Free style (follow the mouse)' icon: /v

‘Use straight lines' icon:

e

Figure 4. Using the eraser to retouch a section in the design.
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5.08 Draw objects; ling, square, circle, ...

The drawing toolsicon bar contains al the drawing tools to create objects with specific shapes such as
lines, dots, circles and squares. The objects provide accuracy in your drawings and are indicated in blue
on screen.

General operation for thetools

After selecting a drawing tool, a second vertical toolbar will appear. Depending on the tool, this toolbar
will present you with a number of options that can be selected before the object is placed in the design.

To place the object, move the mouse to the drawing area and click where the object should be placed. The
cursor will also indicate the selected drawing tool. Hold and drag or click in a second position to
determine the size and position of the object. Purple markers on or around the objects allow for
repositioning, resizing or changing the proportions.

An object as awhole can be deleted by the delete key or selecting 'Delete’ from the icon bar or context
menu. It is not possible to erase parts from the object unlessit has been fused to the bitmap (see:
"Working with fused bitmaps)).

After placing an object in the design, a second vertical toolbar will appear, presenting the specific
properties for the drawn object. Reselecting the object later on will bring up the same propertiesicon bar.

A number of properties are common for all objects. These will be explained in a separate section:
Common properties for objects.

Drawing straight lines

To draw astraight line, choose the 'Draw Straight Line' icon from the toolbar on the left side of the
screen. In the design area, click the starting position for your line, then click the end position.

97/ 187


http://thinkable.nl/?p=171

TactileView softwar e manual
Visit us at http://thinkable.nl

Figure 1. Drawing a straight line in the design.

‘Draw straight line' icon: \

Drawing squares and rectangles

To draw a square, choose the Draw Square-Rectangle icon from the tool bar on the left side of the screen.
Click in the design to mark the position of the first corner, then move the mouse to determine the size of
the square and click a second time to confirm. Alternatively, you can click and drag, then release at the
opposite corner.

By dragging the markersin one of the four corners the size can be increased or decreased. Dragging
inwards or outwards with the markers in the middle of the four sides will turn the square into arectangle.

Figure 2. A square and rectangle drawn in the design.

'‘Draw sguare-rectangle' icon:

Drawing circlesand ellipses

To draw acircle, choose the 'Draw Circle-Ellipse' icon from the left vertical tool bar on the left side of the
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screen. In the design area, click the location for the first position, then move the mouse until the circleis
the desired size and click again to confirm. Alternatively, you can click and drag, then release at the
opposite corner.

By dragging the markersin one of the four corners the size can be increased or decreased. Dragging
inwards or outwards with the markers in the middle of the four sides will turn the circle into an ellipse.

Figure 3. A circle and ellipse drawn in the design.

‘Draw circle-éllipse' icon:

Drawing triangles

To insert atriangle into your drawing, select the 'Draw Triangl€' icon from the left vertical toolbar. Next,
select what type of triangle to insert from the right vertical properties tool bar that appears.

The bottom four icons on this tool bar show the available types of triangles. From top to bottom, the
triangle types available in the tool bar are right, isosceles, equilateral and scalene. Triangles may be
changed from one type to another after you have placed them in your drawing, but it is easiest to select
the appropriate triangle type prior to inserting the shape.

Once you have selected the type of triangle you want, click the point in the design area where you want
one of the corners and then drag until the triangle is the desired size. Alternatively, you can click and
drag, then release at the opposite corner.

The'Angles and lines' dialog can be used for a more mathematically oriented notation. The corners of the
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triangle are marked with letters A, B and C. By default they will only show on screen (green colour). By
checking 'Characters A, B, C at angular points' in the 'Angles and lines dialog, they will also be presented
in braille characters once embossed.

Triangles can be provided with 3 types of specific lines: altitude, median line and bisector, which will be
embossed as dotted lines.

\VA

Figure 4. Four different types of triangles. right, isosceles, equilateral and scalene. Equal or right
cornersare indicated in green.

AN

‘Draw triangl€' icon:

Drawing polygons

A polygon consists of several lines that are connected as one object. To insert a polygon, choose the
'‘Draw Polygon' icon from the tool bar on the left side of the screen. Click in anumber of positionsin the
design areato draw a polygon. To finish the polygon, click on the first angular point (first purple marker)
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to close the polygon. Alternatively, you can click again on the last placed angular point to make an open
shape. Y ou can also choose these two options from the toolbar or context menu by selecting 'Close
polygon' or 'Finalize the polygon (leave the last connection open)'.

When you have an open polygon selected, two green plus symbols on screen allow you to continue
drawing at the ends of the polygon. Y ou can also choose ‘Continue drawing at first/last endpoint' from the
context menu. The red border around a selected polygon can be used to resize it by dragging the purple
markers.

Y ou can choose between straight and curved lines between the angular points. This allows you to make
use of rounded curvesin your design.

Figure 5. Two polygons show the difference between straight and curved lines.

A

'‘Draw polygon' icon:

Drawing freehand line or closed shape

To draw freehand lines or closed shapes, choose the Draw Freehand Line or Closed Shape icon from the
tool bar on the left side of the screen. In the design area, click the desired starting location and drag the
mouse to create the desired line. To create a closed shape, click the desired starting location and drag the
mouse to create the desired shape, returning to the starting location before releasing the mouse button.
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As with the polygon, you can choose between straight and curved lines between the angular points. The
dashed red border can be used to resize the entire object.

T T T DR T
| |
| |
- -
| |
| |
| |
- - — — — — - - — - — — — .

Freehand line with curved lines.

‘Draw freehand line or closed shape' icon:

Drawing dots
To add round dots to your design, select the 'Draw filled dots from the let vertical toolbar, then click in

your design to position the dot. The size of the dot can be changed with the purple markers. The dot size
can range from only one braille dot up to alarge filled circle of multiple centimetres in diameter.

Different sized dots can range from a single braille dot to several centimetersin diameter.
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'‘Draw filled dots' icon: *+*
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5.09 Draw table

TactileView includes a number of tools for drawing and working with tables. As drawing objects, most
editing commands for tables are the same as for other drawing objects, including the methods with which
to move, center or delete atable, change itsline or fill style, add audio labels or fuse it to the bitmap. For
more information on these topics, please refer to 'Common properties of objects,'Editing objects, 'Adding
audio styles and 'Working with fused bitmaps. The features and commands described in thistutorial are
specific to tables.

Drawing a table

To add atable to your file, choose the 'Draw table' icon from the toolbar on the |eft side of the screen,
then click and drag the mouse in the design to insert atable into your document. Y our table will be
created with the default number of rows and columns, but you can add and/or remove rows and columns
as desired after the table has been inserted.

Another way to add atable to your file isto select 'Draw table' from the Drawing Tools menu. This
launches adialog, allowing you finer control over how the tableisinitially created.

To insert atable using this method, enter the desired location of the upper left corner of the table, then
specify the size parameters, the number of rows desired and the number of columns desired. When setting
the size, choose the 'Enlarge/reduce’ radio button if you would like the cellsin your table to be square, or
choose the 'Stretch'’ radio button to alow adjustment of the height and width independently. Enter the
desired cell width (and the height, if using the 'Stretch’ option), the desired number of rows and the
desired number of columns, then choose 'OK' to close the dialog and insert the table into your drawing.
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ki

Figure 1. Drawing a table in the design with the mouse.

HH

‘Draw table' icon:

Adjusting thetable size

Once you have inserted the table into your drawing, you can adjust the overall table size. To do this,
select the table so that purple squares appear along the outside edges of the table. To scale the table and
preserve the height to width ratio, click a purple square in one of the corners of the table and drag it until
the table is the desired size. The cellsin the table will be scaled up or down automatically with the table
and will maintain their height to width ratios.

To adjust the overall table width, click the center purple square on the right or left edge of the table and
drag it until the table is the desired width. The cellsin the table will be scaled automatically to maintain
equal widths. Similarly, you can adjust the overall table height by clicking the center purple square on the
top or bottom edge of the table and dragging it until the table is the desired height. The cellsin the table
will be scaled automatically to maintain equal heights.
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Adding and removing rows and columns

If you created your table using the tool bar icons and the default number of columns and/or rows is not
what you need, you can add or remove rows or columns.

To add arow, select the table and choose the 'Add row' icon from the tool bar at the left side of the
screen, or right-click the table and choose 'Add row' from the context menu. A dialog will appear,
allowing you to choose where in the table to add the row and how to change the size of the table or rows
to accommodate the new row.

First, choose the 'Keep table' dimensions radio button if you want to maintain the current outer
dimensions of the table (scale the row height of all rows down to add the new row without changing the
overall table size), or choose the 'Keep cell dimensions' radio button if you want to add arow with the
same dimensions as the cells currently in the table (increase the overall height of the table to add the new
row with the same row height as current rows). Next, select where to add the new row. To add the new
row at the top of the table, choose the 'In front' button to close the dialog and add the row. To add it at the
bottom of the table, choose the 'At the end' button to close the dialog and add the row. To add it
somewhere else in the table, use the 'After row' edit box to enter the row number after which the new row
should be added, then choose 'OK" to close the dialog and add the row.

To remove arow, select the table and choose the 'Delete row' icon from the tool bar at the left side of the
screen, or right-click the table and choose Delete Row from the context menu. A dialog will appear,
allowing you to choose which row in the table to remove and how to change the size of the table or
remaining rows onceit’s removed.

First, choose the 'Keep table' dimensions radio button if you want to maintain the current outer
dimensions of the table (increase the row height of all remaining rows to remove the row without
changing the overall table size), or choose the 'Keep cell' dimensions radio button if you want to remove
the row without changing the height of the remaining rows (decrease the overall height of the table when
the row isremoved). Next, choose which row to remove. To delete the row at the top of the table, choose
the 'First' button to close the dialog and remove the row. To delete the row at the bottom of the table,
choose the 'Last’ button to close the dialog and del ete the row. To delete any row in between, use the
'Delete row' edit box to enter the row number to remove, then choose 'OK' to close the dialog and delete
the row.

Similarly, you can add or remove columns in the same way as described for rows. Instead, select the ‘Add
column' icon from the properties toolbar or rightc-click the table and choose 'Add column’' from the
context menu. To remove a column, select the table and choose the 'Delete column icon’ from the tool bar
at the left side of the screen, or right-click the table and choose Delete Column from the context menu.
Similar dialogs will appear, in which you can select where to add or remove a column in the table.
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‘Add row' icon: %

£ :
£
£

‘Add column' icon:
‘Remove row' icon:

'Remove column' icon:

Entering table contents

At any point after creating your table, you can enter contents into the cells. Y ou can use the drawing tools
from the left vertical toolbar or Drawing tool menu to place text labels or object in the table. Objects
inserted into atable may be edited just like objects that are not part of table contents (for more
information, please refer to the 'Drawing tools icon bar' and 'Editing the design’ sections of the manual).
Inserting an object into the table contents will anchor it to the table, so that if you later move, stretch or
scale the table, the object stays linked to the correct cell in the table.

As an aternative to drawing the object with the mouse, select the table and choose the 'Table contents
icon from the properties toolbar, or right-click the table and choose 'Table contents' from the context
menu. This launches a dialog from which you can control the table content.

When you select an object type from this menu, a dialog will come up allowing you to give further
information about the object you want to create. What is on the dialog will vary depending on which type
of object you select. A size and position dialog will appear for straight lines, squares/rectangles,
circles/dlipses, triangles, polygons, freehand lines/closed shapes, dots and tables. For the other objects, a
dialog will appear in which the contents can be entered (e.g. text labels) or selected (e.g. figures).

The dialogs are very similar to the ones that appear when you access the drawing tools from the Drawing
Tools menu, except that they also have edit boxes that allow you to select which cell to place the object in
by specifying the desired row and column for the object.

Thisisthe size and position dialog for inserting a square, but sinceit is being inserted into atable it has
Row in Table and Column in Table edit boxes at the bottom. Make the desired selections to create your
object and place it in the appropriate cell, then choose OK to close the dialog and insert the object into the
table. It will also appear as alisting in the table contents menu.
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Figure 2. Scaling or moving a table will automatically reposition the contents in the table.

'Table contents' icon:
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108/ 187



TactileView softwar e manual
Visit us at http://thinkable.nl

5.10 Draw graph

The 'Draw graph' icon shows the list of options for creating a tactile mathematical graph. Y ou can also
find these options in the Graphs menu. From thislist, you have a choice to either use an empty grid,
create a graph by entering your own formula or using one of the TactileView example graphs.

There are alot of different aspects when it comes to mathematicsin braille and creating or reading tactile
graphs. The detailed introduction will explain everything you need to know about the background
concepts. In the other entriesin the 'Graphs and math' section of the manual you can read how to use
different styles of graphs and learn how to create them using different input methods.

‘Draw graph' icon:
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5.11 Add figure (imagefilesor arrows, symbals, ...)

To add arrows or other commonly used shapes, choose the ‘Add Figure' icon from the tool bar on the | eft
side of the screen, then select 'Add figure' again from the second vertical toolbar. In the design area, click
on the point where you want the figure to be inserted. A dialog containing alist of available figure
categories including arrows, electrical symbols and more appears. (NOTE: Y ou can also add your own
commonly used shapes as figures so that you can easily insert them into files. Please refer to 'Select area
for more information.)

—
'Add figure' icon; =

Select a Figure “

Select an item

=] arrows

+- cloged arrows

"] open arrows S T
L. ppen arrow 01.png > a_‘\
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H
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personal folder
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Figure 1. From the dialog, choose one of the figures supplied with TactileView, or insert one of your own
saved images.

Browse through the categories and select a figure to add, then choose 'OK’ to place the figure in the
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design. If the object is not the desired size when it appears in the design area, you can edit it by dragging
the purple markers on the corners and sides.

Alternatively, you can insert a saved image file as afigure in the design. Y ou can choose 'Import SVG' to
insert an svg image in your design, or ‘'Import image from file' to insert a bitmap image (.jpg, .png, ...) asa
figure.

See Importing images from the internet for more information on using images in your design.

+

'Add figure' icon: "5
—
'Add figure' icon: '
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5.12 Draw mammoth braille

The dots of braille characters normally have afixed distance, but this can be enlarged. In TactileView, the
greatly enlarged braille is called 'mammoth braille' to distinguish from Jumbo braille (braille with
increased dot distance).

NOTE: Mammoth braille is not used to place braille texts in the design, but could be used for ‘fun’
applications such as writing aname in alarge braille character type. The braille dots will be displayed in
blue on screen. The character that is represented by the dots is shown in grey behind the braille dots.

To draw alarge braille in the design, select the 'Draw mammoth braill€' icon from the left vertical toolbar.

Click in the design where you wish to place the mammoth braille. Enter the contents in the dialog that
appears and click 'OK". Y ou can use the purple markersto resize the enlarged braille.

‘Mammoth braille' icon: m&

.se® & 8 8 @ ® @
* &0 OO
® & & L &
® L & ¢ & [ &
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Figure 1. Mammoth braille inserted in the design.

Figure 2. The dot size of mammoth braille can be enlarged, as opposed to regular braille.
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5.13 Draw lettersand digits

NOTE: Keep in mind that this drawing tool is not intended to present texts in braille, but as atool to show
the contours and shapes of visual text characters. Various font types and font sizes can be used to
illustrate font attributes such as serif, italic or bold.

To draw atext in the design, select the 'Draw letters and digits icon from the left vertical toolbar. Click in
the design where you wish to place the large text. Enter the contents in the dialog that appears and click
'OK". You can use the purple markers to resize the text, which should be large enough for tactile use to
distinguish the characters.

o Txt
'‘Draw letters and digits icon:

letters
and digits

Figure 1. Add large text to your design with ‘Draw letters and digits

font

size

Figure 2. Font type and size for letters and digits can be adjusted.

. ahA
'Font type and size' icon:
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6.01 Different types of text labels

Y ou may add text format labelsto afile at any time. There are several formats of labels available for use
in TactileView. The most commonly used type of label in TactileView isreferred to smply as a*text
label.” Text labels may be entered in plain text and be automatically transated to braille when they
appear in the document, or they may be entered directly in braille through six-key input.

In addition to text labels, TactileView offers the option to add mammoth braille labels or print character
labels that will be embossed as raised text.

NOTE:

Labels may only be edited according to the input method used to create them. For example, atext label
entered via braille (six-key) input may only be edited using six-key, and araised print character |abel may
only be edited as araised print character label. Labels can’t be converted from one type of label to
another.

Adding text labels

The most commonly used type of label in TactileView isreferred to ssimply as a“text label.” Text labels
may be entered in plain text, and then they are automatically translated to braille when they appear in the
document. If you do not already have afile open, create or open onein TactileView to work in.

To add atext label, click the Add Text Label icon and then click the location in the design area where
you'd like to place your text label. A text label will appear in the design, allowing you to enter your text,
which will immediately become visible in the design. If you have not yet selected a braille table for your
trandation, adialog will pop up, in which you can select a braille table.

[Note: For US English braille, select atable starting with “en-us.” En-us-gl is the standard US English
braille table for producing Grade 1 braille, and en-us-g2 is the standard one for US English Grade 2.
Please refer to the Adding and Editing Braille Tables tutorial for information on how to edit existing
braille tables or add your own.]

If you'd like, you can adjust the location for the text label by selecting it and dragging it to its desired
location in the design. Y ou can aso control the width of the text label by selecting the label and clicking
and dragging the purple squares surrounding the selected label to adjust its width.

The text label will appear in your file with the braille shown in black with the original text you entered in
green on top of it, and there will be a green dot on the left edge of the label to indicate atext label entered
with the computer keyboard (rather than braille keyboard entry).

Once you've inserted alabel, you can make additional labels either by following this process again, or
you can copy and paste your first label and then edit the text in the copy.

Adding text labelsthrough six-key entry

116/ 187



TactileView softwar e manual
Visit us at http://thinkable.nl

This option isonly available from the tool bar on the left side of the screen. Click the Add Text Label
icon and then choose the braille keyboard entry icon. Click the location in which you would like to insert
your label and atext label will appear in the design, alowing you to enter your text, which will
immediately become visible in the design.

Enter the braille you would like in your label one character at atime. To enter a character, press al letter
keys for the dots you want in your character at the same time, then release them at the sametime. The
letters f, d and s correspond to dots 1, 2 and 3, respectively, in the cell and the lettersj, k and | correspond
to dots 4, 5 and 6, respectively. For example, the letter n contains dots 1345. To enter this character, press
f, s, j and k all at the same time, then release them.

If you'd like, you can adjust the location for the text label by selecting it and dragging it to its desired
location in the design. Y ou can also control the width of the text label by selecting the label and clicking
and dragging the purple squares surrounding the selected label to adjust its width.

The text label will appear in your file with the braille you entered shown in black. Letters that correspond
to the braille character in the US English braille table are shown in green on top of the braille, but the
braille itself should be checked for accuracy, not the green text. The green text will not be embossed.
There will be ayellow dot on the left edge of the label to indicate atext |abel entered with the braille
keyboard (rather than computer keyboard entry).

If you input atext label using the braille keyboard (six-key) input method, it may only be edited using six-
key. The Add Text Label function will stay in braille keyboard entry mode until you click the Add Text
Label icon and then either click the computer keyboard entry icon or right-click in the design area and
select Text and position: computer keyboard entry to change it back. The Add Text Label function will
also be automatically reset to use computer keyboard entry if you close and reopen the software.

Adding mammoth braille labels

To add mammoth braille l1abels, click the Draw Mammoth Braille icon in the tool bar on the left side of
the screen, then click the location in the design area where you would like to place the label. In the dialog
that appears, enter the text you wish to appear in mammoth braille and adjust the position in which it
should be inserted if desired. Choose OK to close the dialog and insert the mammoth braille [abel into
your file.

The mammoth braille label will appear in your file with the mammoth braille dots shown in bright blue.
The original text you entered will appear behind the mammoth braillein light blue.

Adding raised print character labels

To add print characters that will be embossed in the shape of print letters, choose the Draw Letters and
Digitsicon from the tool bar on the |eft side of the screen, then click the location in which you'd like the
raised print character label to be inserted. Thislaunches a dialog that alows you to enter the text you wish
to appear as print characters and adjust its location in the design area if necessary. Set the options as
desired and choose OK to close the dialog and insert the [abel into your file.
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6.02 Editing text labels

Any text label placed in the design can still be edited later on. Y ou can change the contents of the label or
adjust the size and position in the design.

Please note that 1abels may only be edited according to the input method used to create them. For
example, atext label entered viabraille (six-key) input may only be edited using six-key, and a raised
print character label may only be edited as araised print character label. Labels can’t be converted from
one type of label to another.

Changing how labels are viewed (computer or braille keyboard entry text labels)

To view only the text of the labels in your document, select atext label and then choose the 'Text Label
Presentation: on Screen' icon from the tool bar on the left side of the screen. and then choose Hide Braille
on Screen, or right-click atext label and select the 'Text Label Presentation on Screen' option from the
context menu to do the same.

Alternatively, to show or hide the braille dots, select atext label and choose the 'Show/Hide Braille Dots
on Screen' icon from the tool bar on the |eft side of the screen, or right-click atext label and select the
'Show braille dots on screen' option from the context menu.

NOTE: Hiding the braille dots on screen does not hide the braille in mammoth braille labels. Braille dots
for text labels can be disabled on print seperately.

"Text label presentation on screen' icon:

'R 1) R 1)
[T R e - -
' 1. [

'Show/Hide braille dots on screen' icons: * ¥

Cutting, copying, pasting and deleting labels (all label types)

The fastest way to copy, cut, paste or delete alabel is using hotkeys. To cut alabel, select it and press
CTRL+X on the keyboard. Cutting the label removes it from the file but stores it on the clipboard so you
can paste it somewhere else in the file. The cut label can only be pasted until you cut or copy a different
label or object.

To copy alabel, select it and press CTRL+C. Copying leaves the original 1abel but keeps a copy of it that
you can paste somewhere elsein the file. To paste a cut or copied label, press CTRL+V. To delete a
selected label, press the Delete key on the keyboard.
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Moving labels (all label types)

Once your label is selected, you can move it by clicking the center and dragging it to a new position. A
four pointed arrow cursor indicates you can move the label.

Y ou can also easily move the label to the center of the design area by right-clicking it and selecting
Center from the context menu. Y ou can move it only horizontally or only vertically by right-clicking it,
selecting 'Move the label or object only horizontally or vertically' and then dragging it up or down to
move it vertically without changing its horizontal position, or left or right to move it horizontally without
changing its vertical position.
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Figure 1. The cursor with four arrows indicates the text label will be moved when dragged.

'Centretext label' icon: 'ﬁil

‘Move horizontally/vertically' icon: T"—»

Resizing labels (mammoth braille labels and raised print character labels only)

Y ou can resize amammoth braille label in one of two ways. The first way is to scale amammoth braille
label manually. To do this, select it, then click a purple marker in one of the corners of the label and drag
it diagonally until the label isthe desired size. This resizes the mammoth braille inside the label to fit the
new label size. The other way to resize amammoth braille label isto right-click it and choose 'Braille dot
size', which brings up adialog on which you can specify the size of the mammoth braille relative to
standard braille as a percentage. The default percentage is 300, which means the mammoth braille is three
times larger than standard braille. Enter the desired size of the mammoth braille and choose OK to close
the dialog, adjust the mammoth braille size and automatically resize the label to fit the new size of the
mammoth braille.

Raised print character labels may also be resized in one of two ways. The first way is the same as for
mammoth braille labels; select the raised print character 1abel, then click a purple square in one of the
corners of the label and drag it diagonally until the label isthe desired size. This resizes the raised print
charactersinside the label. The other way isto right-click the raised print character label and choose 'Font
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type' and size from the context menu. This launches adialog that allows you to choose any font on your
computer for the label, to specify any available font style for that font and to define the desired font size.
Once you have finished making selections, choose OK on this dialog to apply your choices to the label
text. The raised print character label will be resized to fit the new size of the text.

NOTE:

Because braille characters have afixed size, text labels created using either computer keyboard entry or
braille keyboard entry may not be resized. However, you can determine the width of the text by adjusting
the word wrap of the text label. Read more >
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Figure 2. Mammoth braille or letters and digits can be resized using the purple markers.

Rotating labels (all 1abel types)

To rotate alabel, right-click it and then choose 'Rotation’ from the context menu or click theicon in the
toolbar of the selected label. On the dialog that appears, enter the desired angle of rotation in degrees and
choose OK to rotate the label. Y ou can also use the scroll wheel on a mouse to rotate a selected label.

'Rotation’ icon:

Editing text label content

Text labels may only be edited using the same entry method with which they were created (computer
keyboard entry or braille keyboard entry). To edit the content of the computer keyboard entry text |abel,
double-click the label to place the cursor in the text and edit the content as desired within the design area.
Y ou can also right-click the label and choose 'Text and position: computer keyboard input' or click on the
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corresponding icon in the toolbar to bring up atext and position dialog. Make the desired changes and
choose 'OK" to update the text in the label.

To edit the contents of a braille keyboard (six-key) entry label, right-click it and choose "Text and
position: braille keyboard input' to bring up the text and position dialog. Edit the label content as desired
using six-key entry. When you are finished, choose 'OK' to close the dialog and update the label.
Alternatively, you can double click on the label to edit its contents directly in the design area.

- B

Figure 3. Double click on a text label for direct editing.

Editing mammoth braille

To edit the content of a mammoth braille label, right-click it and choose Text and position mammoth
braille to bring up the text and position dialog you used to create the label. Edit the label content as
desired, then choose OK to close the dialog and update the label.

Editing lettersand digits

To edit the content of araised print character label, right-click it and choose Text and position:
letterg/digits to bring up the text and position dialog you used to create the label. Edit the label content as
desired, then choose OK to close the dialog and update the label.
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6.02 Editing text labels - revision

Any text label placed in the design can still be edited later on. Y ou can change the contents of the label or
adjust the size and position in the design.

Please note that 1abels may only be edited according to the input method used to create them. For
example, atext label entered viabraille (six-key) input may only be edited using six-key, and a raised
print character label may only be edited as araised print character label. Labels can’t be converted from
one type of label to another.

Changing how labels are viewed (computer or braille keyboard entry text labels)

To view only the text of the labels in your document, select atext label and then choose the 'Text Label
Presentation: on Screen' icon from the tool bar on the left side of the screen. and then choose Hide Braille
on Screen, or right-click atext label and select the 'Text Label Presentation on Screen' option from the
context menu to do the same.

Alternatively, to show or hide the braille dots, select atext label and choose the 'Show/Hide Braille Dots
on Screen' icon from the tool bar on the |eft side of the screen, or right-click atext label and select the
'Show braille dots on screen' option from the context menu.

NOTE: Hiding the braille dots on screen does not hide the braille in mammoth braille labels. Braille dots
for text labels can be disabled on print seperately.

"Text label presentation on screen' icon:
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'Show/Hide braille dots on screen' icons: * ¥

Cutting, copying, pasting and deleting labels (all label types)

The fastest way to copy, cut, paste or delete alabel is using hotkeys. To cut alabel, select it and press
CTRL+X on the keyboard. Cutting the label removes it from the file but stores it on the clipboard so you
can paste it somewhere else in the file. The cut label can only be pasted until you cut or copy a different
label or object.

To copy alabel, select it and press CTRL+C. Copying leaves the original 1abel but keeps a copy of it that
you can paste somewhere elsein the file. To paste a cut or copied label, press CTRL+V. To delete a
selected label, press the Delete key on the keyboard.
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Moving labels (all label types)

Once your label is selected, you can move it by clicking the center and dragging it to a new position. A
four pointed arrow cursor indicates you can move the label.

Y ou can also easily move the label to the center of the design area by right-clicking it and selecting
Center from the context menu. Y ou can move it only horizontally or only vertically by right-clicking it,
selecting 'Move the label or object only horizontally or vertically' and then dragging it up or down to
move it vertically without changing its horizontal position, or left or right to move it horizontally without
changing its vertical position.
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Figure 1. The cursor with four arrows indicates the text label will be moved when dragged.

'‘Centre text label' icon: 'ﬁil

‘Move horizontally/vertically' icon: T"'—>

Resizing labels (mammoth braille labels and raised print character labels only)

Y ou can resize amammoth braille label in one of two ways. The first way is to scale amammoth braille
label manually. To do this, select it, then click a purple marker in one of the corners of the label and drag
it diagonally until the label isthe desired size. This resizes the mammoth braille inside the label to fit the
new label size. The other way to resize amammoth braille 1abel isto right-click it and choose 'Braille dot
size', which brings up adialog on which you can specify the size of the mammoth braille relative to
standard braille as a percentage. The default percentage is 300, which means the mammoth braille is three
times larger than standard braille. Enter the desired size of the mammoth braille and choose OK to close
the dialog, adjust the mammoth braille size and automatically resize the label to fit the new size of the
mammoth braille.

Raised print character labels may also be resized in one of two ways. The first way is the same as for
mammoth braille labels; select the raised print character label, then click a purple square in one of the
corners of the label and drag it diagonally until the label isthe desired size. This resizes the raised print
charactersinside the label. The other way isto right-click the raised print character label and choose 'Font
type' and size from the context menu. This launches adialog that allows you to choose any font on your
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computer for the label, to specify any available font style for that font and to define the desired font size.
Once you have finished making selections, choose OK on this dialog to apply your choices to the |abel
text. Theraised print character label will be resized to fit the new size of the text.

NOTE:

Because braille characters have afixed size, text labels created using either computer keyboard entry or
braille keyboard entry may not be resized. However, you can determine the width of the text by adjusting
the word wrap of the text label. Read more >
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Figure 2. Mammoth braille or letters and digits can be resized using the purple markers.

Rotating labels (all label types)

To rotate alabel, right-click it and then choose 'Rotation’ from the context menu or click theicon in the
toolbar of the selected label. On the dialog that appears, enter the desired angle of rotation in degrees and
choose OK to rotate the label. Y ou can aso use the scroll wheel on a mouse to rotate a selected |abel.

‘Rotation' icon:

Editing text label content

Text labels may only be edited using the same entry method with which they were created (computer
keyboard entry or braille keyboard entry). To edit the content of the computer keyboard entry text label,
double-click the label to place the cursor in the text and edit the content as desired within the design area.
Y ou can also right-click the label and choose 'Text and position: computer keyboard input' or click on the
corresponding icon in the toolbar to bring up atext and position dialog. Make the desired changes and
choose 'OK" to update the text in the label.
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To edit the contents of a braille keyboard (six-key) entry label, right-click it and choose "Text and
position: braille keyboard input' to bring up the text and position dialog. Edit the label content as desired
using six-key entry. When you are finished, choose 'OK' to close the dialog and update the label.
Alternatively, you can double click on the label to edit its contents directly in the design area.

SNEI

Figure 3. Double click on a text label for direct editing.

Using additional line spacing

Y ou can also choose to use extra line spacing between lines of text throughout the document, which can
be selected in the grid settings dialog or by selecting 'Additional line spacing’ from the properties tool bar
or context menu of atext label. For example, avaue of 0.5 will add an empty space of half the height of a
braille character between two lines of text. This line spacing is visible on screen in the braille grid.

‘Additional line spacing' icon: &

Figure4.

Editing mammoth braille

To edit the content of a mammoth braille label, right-click it and choose Text and position mammoth
braille to bring up the text and position dialog you used to create the label. Edit the label content as
desired, then choose OK to close the dialog and update the label.
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Editing lettersand digits

To edit the content of araised print character label, right-click it and choose Text and position:
letters/digits to bring up the text and position dialog you used to create the label. Edit the label content as
desired, then choose OK to close the dialog and update the label.

Download as pdf
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6.03 Editing obj ects

NOTE:

Thistutorial does not cover the use of the menu driven design feature in TactileView. Please refer to the
Accessible Drawing tutorial for more information on editing TactileView files through menu driven
design.

TactileView offers anumber of ways to edit existing objects. Drawing objects are indicated in blue, and
al functions listed here will work for these objects. Most will also work for freehand lines that were
converted to objects.

To edit an object, click on it to select it. Purple squares will appear at points used to define the object. In
most cases, these squares appear along the outline of the object. Objects inserted using the Add Figure
feature and freehand lines that have been turned into objects will be surrounded by ared dashed rectangle,
with purple and red squares along the dashed rectangle. If you added afreehand line using the
Retouching: Adding Lines option it will appear in black on screen, and you will need to convert it to an
object before editing (please refer to the Working with a Fused Bitmap tutorial).

Cutting, copying, pasting and deleting obj ects
(all object types)

The fastest way to copy, cut, paste or delete an object is using hotkeys. To cut an object, select it and
press CTRL+X on the keyboard. Cutting the object removesit from the file but remembersit so you can
paste it somewhere else in the file. The cut object can only be pasted until you cut or copy a different
object. To copy an object, select it and press CTRL+C. Copying leaves the original object but keeps a
copy of it that you can paste somewhere else in the file. To paste a cut or copied object, press CTRL+V.
To delete a selected object, press the Delete key on the keyboard.

Moving objects
(all object types)

Once your object is selected, you can move it by clicking the center and dragging it to a new position.
Y ou can also easily move the object to the center of the design area by right-clicking it and selecting
Center from the context menu.

Resizing objects
(all object types)

To change the width of an object, click a purple square on the left or right edge of the object and drag it
horizontally until the object is the desired width. To change the height of an object, click a purple square
on the top or bottom edge of the object and drag it vertically until the object isthe desired height. To scale
an object without changing the height to width ratio, click a purple square in one of the corners of the
object and drag it diagonally until the object isthe desired size.

In the case of afreehand line or closed shape, or for a polygon, clicking and dragging a purple square will
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move only the point located at that purple square. To resize one of these objects, right-click it and choose
Size and Position from the context menu. Thiswill bring up a Size and Position dialog.

In the Size section of the dialog, choose the Enlarge/Reduce radio button if you want to scale the object,
then specify the desired width or height (the other dimension will adjust accordingly to preserve the
original height to width ratio). Choose OK to scale the object. If you want to change the height and/or
width independently, choose the Stretch radio button, then make the desired changes to the height and/or
width of the object. Choose OK to close the dialog and update the object.

Rotating objects
(all object types)

To rotate an object, right-click it and then choose Rotation from the context menu. On the dialog that
appears, enter the desired angle of rotation in degrees and choose OK to rotate the object. Y ou can also
use the scroll wheel on a mouse to rotate a selected object.

Mirroring objects
(figures and retouched objects)

Mirroring an object keeps it in the same position but flips it horizontally or vertically depending on your
selection. Mirroring an object horizontally flipsit left to right (like turning a page in abook). Mirroring
an object vertically turnsit upside down (like flipping a page in awall calendar). To mirror an object,
right-click it and choose Mirror Horizontally or Mirror Vertically from the context menu.

Changing theline style
(does not apply to figuresor retouched objects)

Select the object and choose the Line Style icon from the tool bar on the left side of the screen, or right-
click the object and select Line Style from the context menu. Either of these methods opens a dialog from
which you can set the line properties for the object, including the line pattern (solid or dashed) and
thickness. The dialog includes a preview of how your line will look as you make changes. Choose OK to
apply your changes to the object and close the dialog.

Changing thefill style
(does not apply to figuresor freehand objects)

Select the object and choose the Fill Style icon from the tool bar on the left side of the screen, or right-
click the object and select Fill Style from the context menu. Either of these methods opens a dialog from
which you can set the fill properties, including selecting afill texture, scaling the size of thefill tiles and
rotating the texture within the object.

If you would like to add afill texture to your object, select the Use Texture Fill radio button. Choose the
Change Texture button to bring up a dialog containing alist of textures that can be used. Select atexture
and choose OK. A preview of your texture appears at the bottom of the fill style dialog. Use the Tile Size
in Pixels edit box to scale the texture larger or smaller. Y ou can also rotate the texture using the Texture
Rotation Angle edit box. When you are finished making changes, choose OK to apply thefill style.
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6.04 Using audio styles

Audio styles agreat way to add more information to a drawing without having to make it larger to
accommodate more text or graphical information. The audio information is accessed by using thefilein
explore mode, either on screen with a mouse or on atactile copy on the Clickpad or Tactipad with the
digital pen. For more information on explore mode, please refer to the Using Explore Mode and Using the
Pen in Explore Mode with the Clickpad or Tactipad tutorials.

Audio styles can be added to any type of drawing object in TactileView (figures, squares, circles, dots,
detected area, etc.). Audio styles may not be added to text labels, because text labels are automatically
voiced by text-to-speech when the file is used in explore mode (the text contents of the label is used as an
audio style).

Adding an audio styleto be voiced by text-to-speech

To add an audio style to be voiced by text-to-speech to an object, select the object and then choose the
'‘Audio style' icon from the properties toolbar on the left side of the screen or right-click the object and
choose 'Audio style' from the context menu. Thiswill launch an audio style dialog, the top section of
which allows you to specify the text to be voiced by synthetic speech from one of several sources.

The default choice isthe 'Self defined text' radio button, which allows you to type the text you want
voiced into the text field on the dialog. If you have text saved in atext file that you would like voiced
instead, you can select the 'Text from local fil€' radio button, then choose the 'Browse' button to browse to
and select your text file (.txt file). Once you have specified the text, you can check how the audio style
will sound by selecting the "Test audio style' button. When you are finished making changes, choose the
'OK" button to close the dialog and apply the audio style. The object will be shaded light pink to indicate
that an audio style is associated with it.

Figure 1. Thelight pink colour signifies an audio style is associated with the circle.
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Attaching an existing sound fileto an object

Y ou can also attach an existing sound file to an object to have it played when the object is clicked while
thefileisin explore mode. In the audio style dialog, the bottom section allows you to specify a sound file
to be used as an audio style.

The default choice isthe 'Local file' radio button, which is used to attach a sound file to the object as an
audio style. Select the 'Browse URL' button, locate the sound file you would like to use on your computer
and select it. Thefile path to the sound file will now appear in the text field below the sound file type
selection radio buttons. Y ou can check how the audio style will sound by selecting the 'Test audio style'
button. When you are finished making changes, choose the 'OK" button to close the dialog and apply the
audio style. Thelight pink colour will now indicate an audio style is associated with the object.

NOTE:
If you have both a text-to-speech audio style and a sound file audio style attached to the same object, the
text-to-speech will be voiced first and the sound file will play after it.

Recording an audio style from a microphone

Audio styles recorded from a microphone are played when the object is clicked with the mouse or digital
pen while using the file in explore mode. Recorded styles are played after any text-to-speech styles are
voiced. Before recording, you will need to ensure that you have a microphone connected to your
computer. Y ou can connect your microphone viathe 'Microphone' dialog in the Settings menu.

When you have connected a microphone to your computer, you can record an audio style for an object by
selecting the object, then choosing the 'Record microphone' icon from the properties toolbar on the left
side of the screen, or by right-clicking the object and choosing 'Record microphone' from the context
menu. As soon as you select this, recording begins and the icon in the tool bar changes to the 'Stop
recording' icon. When you have finished speaking into the microphone, choose the 'Stop recording' icon
from the tool bar or right-click the object and select 'Stop recording' from the context menu to stop the
recording. Y our recording will play back automatically as soon as you stop the recording, and the object
will be shaded light pink to indicate that an audio styleis associated with it.
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NOTE:

Each object may only have one text-to-speech audio style and one recorded or sound file audio style
associated with it. If you record an audio style for an object, it will replace any existing sound file you
may have associated with that object previously.

Editing an existing audio style

To edit any type of audio style, select the object with the audio style you want to edit and then choose the
Audio Styleicon from the tool bar on the left side of the screen or right-click the object and choose Audio
Style from the context menu. Thiswill launch the same audio style dialog you used to create a text-to-
speech audio style or attach an existing sound file.

To edit a synthesized speech audio style from self-defined text, edit the text in the text field. Y ou can also
remove the text-to-speech audio style by deleting the text from the text field in the top section of the
dialog.

To edit a synthesized speech audio style from text from alocal file, you will need to edit the text within
the text fileitself. To load text from a different file, select the Browse button, locate the new text file you
would like to use and select it. Y ou can also remove this audio style by deleting the file path to the local
file from the text field in the top section of the dialog.

To edit an audio style played from a sound file, choose the '‘Browse URL' button, browse to a different
sound file on your computer and select it. It will replace the previous sound file, including any sound file
recorded from a microphone, as the audio style for that object. To remove the sound file audio style,
delete the file path of the sound file from the text field in the bottom section of the dialog.

When you are finished making changes, choose the 'OK" button to close the dialog and apply your
changes.

If you would like to re-record an audio style from your microphone, simply follow the steps given above
for recording from a microphone. Y ou do not need to open the audio style dialog to do this. Please
remember that recording an audio style for an object from the microphone will overwrite any other sound
fileaudio style for that object.
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7.01 Introduction on mathematical notations

Equations for sighted users are usually written in a spatial arrangement, in such away that the
components and their relations can be understood from their relative positioning. For example, adivision
is depicted by placing the dividend above the divisor, separated by a horizontal division line.

For printing in braille, this spatial arrangement has to be converted into a continuous line of braille
characters. Mathematical symbols such as (large) brackets, square roots and many other non-day-to-day
symbols have to be converted as well.

M athematical notations and braille tables

Since computers began to play arole in math and science, it has become even more a necessity to find an
unambiguous way of presenting the results (in braille as well). Many of the equation editors use MathML
astheir universal language to store and manipulate mathematical equations. This language is also used to
add equations to your design in TactileView.

In order to get the correct equation printed in braille, a 2-step conversion is required: applying
mathematical notation rules and applying a braille table to trand ate the characters into the corresponding
braille dots.

l—x

N > rscldlsane T o>

X —

v
i3

Original equation Mathematical rules Braille table applied Mathematical text label in
applied TactileView design

Figure 1. Conversion from an equation in MathType to a mathematical text label in TactileView, by
applying the chosen mathematical notation (in this case LaTeX) and braille table (en-us-comp8.ctb).

A math notation applies a set of rulesthat convert the spatial elements from the graphical lay-out
(MathML) into a continuous line of text. Extra characters need to be inserted to indicate the relationship
of the parts, to depict specia mathematical symbols or to signify the logical order of the elements.
Amongst other, the Nemeth, Unified English Braille, LaTeX, Marburg and Dedicon are some of the
better known math notations and are available in TactileView.

The result of the first conversion step is that the equation has become readable astext in alinear instead
of a spatial arrangement. During the second step, a'braille trandator' (in TactileView, the open source
project LibLouisis used) applies the desired braille table to convert the linear text of the equation into the
corresponding braille characters.
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7.02 Add mathematical label (equation)

Currently, there are three options for entering a mathematical text label in your TactileView design:

1. Enter the equation in aregular text label, using the corresponding braille table;
2. Use six-key entry (braille keyboard) to directly enter the math in braille;
3. Enter the mathematical expression using a math editor (MathType).

Options 1 and 2 require knowledge about the mathematical braille notation you are using in order to enter
the equation correctly. Option 3 allows you to enter math and convert it automatically to the desired
notation in braille, but this requires MathType as a math editor. In the upcoming service release, afourth
method will be included, which allows you to enter the equation in linear notation and have it converted
automatically (i.e. thiswill not require knowledge of the braille notation or a mathematical editor).

1. Using aregular text label

When you know the rules of the mathematical braille notation you wish to use, you can use aregular text
label to enter it in your design. Select 'Add text label’ from the drawing toolsicon bar, then select "Text
and position: computer keyboard input' from the properties toolbar. Click in the design where you want to
place the equation. Make sure to include the correct spaces, parentheses and other specific aspects of the
mathematical notation. MathType is required when you wish to use symbols that are not on your
keyboard.

Next, make sure to select the correct braille table for the notation you are using. Y ou can select the braille
table by choosing 'Select braille table' from the properties toolbar or context menu. The following braille
tables are recommended for the different mathematical notations:

e nemeth.ctb for Nemeth;

ukmaths.ctb for UKmaths;

marburg.ctb for Marburg notation;
en-us-comp8.ctb or similar for LaTeX;
Dutch braille table for Dedicon notation.

‘Add text label" icon: .
L
'‘Computer keyboard input' icon: Jane

'Select braille table' icon:
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2. Using six-key entry

If you know the mathematical braille code and wish to simply use braille keyboard (six-key) entry for
direct input of the desired characters, please refer to the 'Different types of text labels' section for
instructions on adding text labels through six-key entry.

ood

'Braille keyboard input' icon: Xegg:

3. Equation with math editor (MathType)

Y ou can use MathType as a math editor to automatically convert the entered equation to the desired
braille notation. The math editor is also required to enter math that istoo complex to be entered in linear
format or when symbols are required that are not available on the keyboard. For more information on
using MathType to enter mathematical expressions, please visit their website.

Once you have entered the equation in MathType, select it and copy it to the clipboard (Ctrl+C). Switch
to TactileView, select 'Add text label' and choose 'Text and position: math input' from the properties
toolbar. Click in the design where you wish to position your mathematical label.

In the dialog that appears, select the preferred mathematical notation and click on 'Paste math equation
from clipboard'. The equation will now be displayed in both visual (linear and spatial) and braille format.

The dialog also allows you to adjust the location in which you would like to insert the label (if different
than where you originally clicked in the file) by filling in the distance fields. Y ou can size the label by
specifying the maximum number of characters you would like it to have before the text wraps to the next
line. Choose 'OK" to confirm and close the dialog.

Mathematical text labels may be moved and edited the same as other text labels. For more information,
please refer to the 'Editing text labels section.

Vo
‘Math input' icon: L=
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Figure 1. A mathematical equation in TactileView; LaTeX and en-us-comp8.ctb were used as

mathematical notation and braille table.
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7.03 Graph propertiesfor best tactile usability

When it comes to tactile graphs, there are several properties that together determine the tactile usability.
The three elements in a graph (the equation in braille, grid paper with coordinate system and the curve of
the formula) can be configured individually to achieve the optimal tactile result. Persona preferences of
the VIP reader as well as the properties of the printer that will be used both need to be taken into account.
Therefore we advise you to test the settings described below first to find what works best for you.

Choosing the best graph properties

The mathematical formula(s) and range of the axes are the most important elements when you create a
new graph. All other aspects of the grid are for tactile presentation purposes. Reading atactile graph can
be complex enough on its own, so choosing the optimal settings for your production method (swellpaper
or the type of braille embosser) isimportant. This works best if you can imagine the result of each setting
in advance. Thelist below gives an overview of all the settings that are related to atactile graph.

Graph properties
1. Coordinate system and grid paper
The coordinate system (the axes of the graph) and grid paper (the regular grid that indicates the values of
the graph) form the frame in which the graph will be plotted.
Select 'Positions and appearance' from the properties toolbar or context menu of the graph to access the

'‘Appearance’ settings for the coordinate system and grid paper.

Coordinate system — X and Y axis

- Line thickness of the axis; thicker axislines can be used to distinguish the axes more easily from the
thinner grid lines, but also take up more space and tear more easily on some embossers.

Grid paper
- Draw border to surround the axis; this places a rectangular frame around the entire grid.
- Style of auxiliary linesfor grid boxes; you can choose from: line, cross, dot, dash and none.

- Thickness of the auxiliary linesfor grid boxes; use thinner lines to make the grid boxes less prominent
for better contrast with the formulalines.

- Relief height of auxiliary linesfor grid boxes; you can make the grid lines less prominent and more
easily distinguished from the axes and formulas by lowering the line height. Thisis only available for
embossers that support variable dot height.
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Figure 1. Differencesin line thickness are used for easy tactile distinction between the grid boxes and
axes.

Figure 2. A border is used around the edges of the graph.
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Figure 3. Four different grid box styles: line, dash, cross and dot.

Figure 4. A lower line height, indicated with a lighter blue colour, can be used for easy distinction of the
grid boxes.

2. XandY axes
These settings can be adjusted separately for the horizontal (X) and vertical (Y) axis.
- Extreme values for the axis; this determines the range in which the graph is shown.

- Subdivision of the axis: units per grid box and units per tick; you can choose the interval that is used for
the grid boxes and ticks along the axis to easily read the values of the graph.

- Ticks per text label; you can choose whether a numeric value should be placed at each tick, more spaced
out (e.g. 1 text label for every 2 ticks) or only at the origin/ends.

- Number of decimals of the values along the axis; some graphs might require more decimal numbers.
- Position of the labels relative to the graph's border; this allows you to create enough space between the

grid and value labels along the axis. In the design, you can also drag the purple marker below or left of
the values to move them to the required position with the mouse.
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- Name for the axis; by default, these are 'x' and'y', but you can change this to suit the graph (e.g.
‘Number purchased' and 'Price).

- Horizontal and vertical position of the axis name; these determine the position of the axis name label. In

the design, you can drag this label to the required position with the mouse. Double click on aformula
label to edit it.

.I

Figure 5. The range for the axes and positions of the ticks, grid boxes and value labels determines the
layout of the axes of the graph

141/ 187



TactileView softwar e manual
Visit us at http://thinkable.nl

0 20 410 60 80 100

Quantity

Figure 6. The axes can be labeled individually (X and Y are the default labels).

3. Formulalines
The settings for each formulaline that is presented in the graph can be adjusted separately.
- Formula syntax; enter the mathematical equation that will be plotted.
- Text label representation of the formula; the legend above the graph shows which formulas are
presented. Y ou can choose from an number of mathematical representations; aternatively, you can
choose to enter your own name (e.g. 'Surface ared) or choose not to include alabel.
- Line style for the formula; by default, each formula gets a different tactile line style to distinguish
multiple formulas in agraph. Thisline styleis also presented in the formulalegend above the graph.

Different colours are used on screen for easy visual recognition.

- Position of the text label; by default, the text labels for the formulas are placed above the graph. In the
design, you can also move these with the mouse.
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Figure 7. Different line styles are used for the formulas in the graph, as signified in the fomula legend.

Different colours are used on screen to easyly distinguish the formulas visually.
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7.04 Creating a graph

TactileView offers avery powerful graphing feature, which allows you to enter formulas and have them
graphed over a specified range. TactileView gives you precise control over the styles used in your graph
for the functions, axes, gridlines, labels and more. Y ou can also move and resize your graph like any
other drawing object.

There are several possible approaches of creating a new graph. Y ou can choose an empty grid as a basis
(see paragraph 1), select one of the TactileView graph examples and adapt it to form your own (see
paragraphs 2 and 3), or create a new graph based on the entered formula (see paragraphs 4 and 5). Y ou
can also save any graph as'MyGrid' for reuse in later designs (see section 'Save graph as MyGrid for later
use).

Y ou can read an overview of all the tactile properties that determine the tactile usability of agraph in the
'Graph properties section. For more information on the different mathematical notationsin braille, read
the 'Introduction on mathematical notations' section.

1. Coordinate system (no functions)

To enter an empty coordinate system (empty grid paper without any graphed formulas), select 'Draw
graph’' from the drawing toolsicon bar, then choose '‘Coordinate system (no functions)' from the properties
toolbar. This option can aso be found in the Graphs menu.

Once this option is selected, an empty grid will appear in the design. By default, thisgrid is square and
ranges from -4 to 4 on both the x- and y-axis, with straight grid lines a an interval of 1 unit. Y ou can use
the options in the properties toolbar or context menu to adjust the properties of the grid or add a graphed
formula.

Coordinate system (no functions) icon:
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Figure 1. Empty grid inserted in a TactileView design.

2. Functions and for mulas (examples)

TactileView includes two sets of ready to use example grids. These have aready been optimized to depict
the selected formula. Y ou can use these graphs as a basis for your own by simply changing the
formula(s).

Select 'Draw graph' from the drawing tools icon bar, then choose 'Functions and formulas (examples)'
from the properties toolbar. Alternatively, this option can also be found in the Graphs menu.

In the dialog that appears you will find alist of sample graphs which each include one formula, ranging
from simple to more complex. By choosing 'Change formula, you can edit the formulato create your own
graph based on the sample. 'Change coordinate system' allows you to adjust the settings for the grid style
and properties of the axes (such asthe range). Use 'Multiple formulas' to add extra formulas to the grid
(for more information on including multiple formulasin one grid, read the '‘Graphing multiple lines
section).

Once you have selected a sample graph or when you are satisfied with the adjustments, you can choose to
insert the graph a blank new document (click 'Save in new document’) or place it in the currently active
document (click 'Save in current document’). Y ou can aso choose to replace the most recent grid in the
current document (click 'Replace the last grid’).

Y=
'Functions and formulas (examples)' icon: iz
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Select a Formula

Select a formula from the list and change the values if necessary, The
graph is drawn on a grid that is suitable for tactile use. The properties of
the grid and the X- and ¥-axis can be adapted.

When you choose to enter a new formula by changing a sample formula, — ¥8
you will find a list of the available functions and constants that can be Rt '
used,

Sample formulas, edit if necessary (39 items):

"
y=x+2: 6<X<6, 4<¥ <4

y=27 N 2-3-10 4N d, A <

y=0.5"x"340, 5% 2-F 42 A<k <4, 5B
y=(0.5"%"3+0,57%"2-3"x +2): -4<X<4, -6<Y <6
y={0.5"%"340.5"x"2-3"x+2)"1 <K <4, 6 <6
y=(0.5"%"3+0.5%%"2-3%x+2)": 4<¥<4, BV <6

y=sqri(x): -2<¥ <6, -1<¥ <4

y=1/sgrt(x): -2<X<5, -1<¥<4

y=1/xi -4<X<4, -4<¥<4

y=1/x"2 4<K<4, 4a¥ 4

y=(1+x)/(1): -6<X <5, -4<¥<d R

Select an option to dose

Change Formua ... Save in new document

. Save in current document
Change coordinate system ...

Multiple Formulas ... —_ = Cancel

Figure 2. 'Functions and formulas (examples)' dialog; click on the image to enlarge.

3. Grids and graphs (advanced examples)

Similar to 'Functions and formulas, the 'Grids and graphs' dialog contains alist of sample grids that can
be used asis, or adapted to create your own grids. The list contains a number of variations of empty grids,
aswell asalist of grids that contain one or more formulas (arranged from simple to more complex).
These examples are labelled as numbered TV Grids. Below these TV Grids, you will find any grids that
were saved for reuse as MyGrids.

Y ou can access this list of sample grids by selecting 'Draw graph’ from the drawing toolsicon bar, then
choosing 'Grids and graphs (advanced examples)' from the properties toolbar. Alternatively, this option
can also be found in the Graphs menu.

Thelist of properties of the selected sample graph is shown in the second list box. If you wish to adjust
any of the settings, select it from thislist and click 'Change properties.

If you have selected one of the MyGrids from the list, you have the option to remove it from the list of
saved grids. When you have adjusted the selected MyGrid, you have the option to either save it as a new
MyGrid or replace the edited MyGrid.

Once you have selected a sample graph, MyGrid or when you are satisfied with the adjustments, you can
choose to insert the graph a blank new document (click 'Save in new document') or placeit in the
currently active document (click 'Save in current document’). Y ou can also choose to replace the most
recent grid in the current document (click 'Replace the last grid’).
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ey
1 H L . W
Grids and graphs (advanced examples)' icon: E=
Select a Grid
Below you wil find a list of sample grids with blank grids or combinations of formulas. These grids can be modified to create your own tactile grids and can be saved

as MyGrids.

Select a sample grid (34 items):
id 1 Graph paper: am; qric Line

TVGrids-Grid 2 Blank square coordinate system: -4<X <4, -4<Y<4; size: 15.32 x 15.32 cm; grid boxes: 8 x 8; style: Line

TVGrids-Grid 3 Blank square coordinate system, dots: -4<X <4, -4<Y<4; size: 15,32 x 15.32 cm; grid boxes: 8 x 8; style: Dot

TVGrids-Grid 4 Blank square coordinate system, dashed line: -4<X<4, -4<Y <4; size: 15,32 x 15,32 cam; grid boxes: 8 x 8; style: Dash hd

Properties of the grid (8 items}:

Positions and Appearance: position: 4.57, 4.57 cm; border ves; style: Ling; line thickness 2; line height 8; formula thickness 2; axis thickness 2
Horizontal (X) Axis: 0<X<18; size: 18,19 cm; grid range: 1; tick size: 1; ticks per label: 0
Vertical (1) Axis: 0<Y<20; size: 19,99 cm; grid range: 1; tick size: 1; ticks per label: 0

M Formula 1:

M Formula 2:

M Formula 3: v

MyGrid Options

Select an option to dose

Save in new document

Save in current document

I}
o
3

Figure 3. 'Grids and graphs (advanced examples)' dialog; click on the image to enlarge.

4. Add custom graph: equation editor

This option allows you to create a graph based on aformulathat is entered using MathType as an
equation editor. The math editor is also required to enter math that is too complex to be entered in linear
format or when symbols are required that are not available on the keyboard. For more information on
using MathType to enter mathematical expressions, please visit their website.

Once you have entered the equation in MathType, select it and copy it to the clipboard (Ctrl+C). Make
sure that the entered formulais suitable for conversion to a graph. Next, switch to TactileView and select
'‘Draw graph' from the drawing tools icon bar, then choose 'Add custom graph: equation editor' from the
properties toolbar. Alternatively, this option can aso be found in the Graphs menu.

In the dialog that appears, select the preferred mathematical notation and click on 'Paste math equation
from clipboard'. The equation will now be displayed in both visual (linear and spatial) and braille format.
Choose 'OK' to confirm.

In the formula dialog that appears, the options below the formula as well as the buttons 'Positions and
appearance, 'Horizontal (x) axis and 'Vertical (y) axis alow you to adjust all the grid properties, formula
labels, line style and axis properties; you can read an overview in the 'Graph properties section. Use the

'‘Apply' button to refresh the graph preview after you have made any changes to the graph.
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Once you are satisfied with the composed graph, select 'OK" to close the dialog and insert the graph in the
design.

JY=
'Add custom graph: equation editor' icon: #x*

Add mathematical equation

Inserting mathematical equations using MathType:

1. Launch MathType and compose an equation.

2. Select the equaticn (ctri+a) and copy it to the clipboard (ctri+c).

3. In TactieView, add a new text label using the option Math input

4. Select the preferred mathematical notabion and press the button "Paste Math Equation from Clipboard™.

Please note: the braile representation of a mathematical equation is determined by a combination of the selected mathematical notation and
the selected braille table.

Select mathematical notation: Text representation: Paste Math Equation from Clipboard
Linear Text ~
Marburg Image scale (%): 200
Nemeth Select Braills table for this text labe:
UkMaths

Letec rmain taie (DUTCH2005) v

Spaiial representation: Eraille representation:

Showhide undertying MathML

Distance to left edge (cm): | 0.00
Distance to top edge (cm): | 0.00

Wrap length (between 10 and 255 characters): |30 Cancel

Figure 4. 'Add custom graph: keyboard input' dialog; click on the image to enlarge.

5. Add custom graph: keyboard input

When you activate '‘Add custom graph: keyboard input’ from the Graphs menu or from the properties
toolbar of 'Draw graph', aformula dialog will open. Enter the formulain the first entry field, making sure
to use the correct syntax (e.g. 2*x instead of 2x, x*2 for x squared, etc.) similar to entering an equation in
software such as Microsoft Excel. Y ou can also select elements from the list of available functions and
constants and insert them into the formula by double clicking on it or pressing the Enter key.

Once again, the options below the formula as well as the buttons 'Positions and appearance', 'Horizontal
(x) axis and 'Vertical (y) axis alow you to adjust al the grid properties, formulalabels, line style and
axis properties; you can read an overview in the '‘Graph properties section. Use the 'Apply’ button to
refresh the graph preview after you have made any changes to the graph.
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Once you are satisfied with the composed graph, select 'OK" to close the dialog and insert the graph in the

design.

Y=

'Add custom graph: keyboard input' icon: #**2

Enter the correct syntax to get a plot of the

desired formula and select a mathematical
notation for the corresponding text label.

Make sure to check the settings for the X-

Y-axis for the range of the graph.

Syntax of Formula 1:

and

y=

Text label representation of Formula 1:
Linear Text
Textlabel of Formula 1:

y=
Line style of Formula 1:

Line
Horizontal position of the textlabel | g.g
relative to the left border {cm):

Vertical position of the textlabel | 2.0
relative to the upper border (cm):

Figure 5. 'Add custom graph: keyboard input' dialog; click on the image to enlarge.

Apply

Formula 1

List of available functions and constants; by double
clicking an element is inserted at the insertion point
in the selected formula:

~
x parameter used in formulas

operators:

+plus, addition operator

- minus, operator for subtraction

* asterisk, operator for multiplication

| slash, operator for division

~ drcumflex, operator for exponentiation

( opening parenthesis

) dosing parenthesis

functions:

abs() absolute value

sqrt{) square root

In) ratural logarithm, base &

log() logarithm, base 10

exp() expanent

sin() sine

cos() cosine v
< >

Positions and Appearance
Horizontal (X) Axis

Vertical (Y) Axis
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7.05 Graphing multiplelines

TactileView provides the ability to graph four or more formulas at the same time. In the 'Creating a graph’
section you can read how to prepare a graph with asingle formula, to which you can add additional
formulas as described below.

Adding aformula

Select the graph in your design to which you wish to add aformula. Similar to creating a new graph,
when adding a formula you need to choose which input method you want to use: you can either enter the
formulawith MathType as an equation editor, or use the keyboard to enter the formula. From the
properties toolbar or context menu of the selected graph, choose 'Add function: keyboard input’ or 'Add
function: equation editor'. In the dialog that appears, you can enter your new formulain the same way as
when you created the graph.

Notice that by default a dashed line style is selected to distinguish the different formulas from each other,
but you can change thisto Line, Dot or Long/Short Broken if you wish. It is recommended to choose a
different line style for each formula you enter. The legend above the graph shows which formula
corresponds with which line style. On screen, four different colours are used to easily distinguish between
the formulas.

Y ou can apply any changesin the graph preview on the right side of the dialog at any time by choosing
the 'Apply' button. When you are satisfied with the selected options for the new formula dialog, choose
the 'OK' button to save your changes, close the dialog and update your graph. In the properties tool bar
you will see that the icon for 'Formula 2' is no longer greyed out, indicating that a second formulais
present in the graph.

Y ou can add athird or fourth formula by following this same process after selecting the graph and
choosing 'Add function: keyboard input' or 'Add function: equation editor' from the properties toolbar or
context menu. If you wish to include more than four formulas, you will need to add the remaining
formulas to one of thefirst four, seperated by a semicolon: e.g. sin(x"2);cos(x"2). These will be plotted as
seperate lines, but with the same line style and other properties.

oY=
'Add function: keyboard input' icon: ***2

Y=
'Add function: equation editor' icon: =’

foix) foi=) fal=
'Formula 1-4' icons: ax) folx) ()
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Figure 1. Different line styles, such as dashed or dotted lines, are used to distinguish different formulasin
a graph; on screen, colours are used to signify these differences.
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7.06 Saving gridsas MyGrids

The example grids (empty grid paper as well as graphs) are called TV Grids. These examples can be
modified to use them as the basis for your own graphs. Any grid can be added to thislist by saving them
as MyGirids. Thisallows you to easily store them for later use. Y ou can find your saved MyGrids below
thelist of TVGridsin 'Grids and graphs (advanced examples)'.

Y ou can save a selected grid as MyGrid by selecting 'Add to MyGrids from the properties toolbar or
context menu. Enter agrid name as a reference, then click 'Y es to save the grid.

‘Add to MyGrids icon: MY

Menu Graphs - Update MyGrids

If you wish to modify or remove any of the saved MyGrids, select 'Update MyGrids from the Graphs
menu and select one from the list.

To modify aMyGrid, select 'Change properties to make the desired changes. After you have applied the
changes, you can choose to save the modified grid as a new MyGrid by selecting ‘Add modified grid to
MyGrids or overwrite the existing one by choosing 'Replace changed grid in MyGrids. Y ou can also
choose to delete one of the MyGrids from the list by selecting '‘Remove grid from MyGrids.
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Update MyGrids

Below you will find a list of sample grids with blank grids or combinations of formulas. These grids can be modified to create your own tactile grids and can be saved
as MyGrids,
Select a sample arid (38 items):

rids-Sine wave: -4<X
MyGrids-Exerdse 1: -4<X
MyGrids-Exerdse 2i -4<X
MyGrids-Exerdse 3: -4<X<4, -4<Y <4; size

5.00 inch; grid be
x 5,00 inch; grid boxes: 8 x 8; style: Line
: 5.00 x 5.00 inch; grid baxes: 8 x 8; style: Line b

Properties of the grid (8 items):

"
Paositions and Appearance: position: 1.80, 1.80 inch; border yes; style: Line; line thickness 2; line height 3; formula thickness 2; axis thickness 6
Horizontal (X) Axis: <4< <4; size: 5,00 inch; grid range: 1; tick size: 1; ticks per label: 1
Vertical (Y) Axis: -4<Y <4; size: 5,00 inch; grid range: 1; tick size: 1; ticks per label: 1
Ml Formula 1: y=sin(x), style: Line
M Formula 2:
M Formula 3: hd

Change properties ...

MyGrid Options
Remove Grid from MyGrids e
Add modified grid to MyGrids A

Replace changed grid in MyGrids wl®

wl AR e

Close

Figure 1. The 'Update MyGrids dialog allows you to edit the list of saved graphs; click on the image to
enlarge.
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8.01 Inserting graphicsin Duxbury Braille Trandator

When you have both TactileView 2.200 or higher, and Duxbury Braille Translator (DBT) 11.3 or higher
installed, you will be able to insert a TactileView design into atext in DBT. This produces a document
containing both text and graphics. Y ou can choose to add a completely new design or use an existing file.
The available space for the image will automatically be taken into account.

If you do not have DBT installed yet, please visit their website.

1. Preparing DBT document

Launch DBT, create a new document and add the text in which you wish to insert tactile graphics. Y ou
can find more information on working in DBT, creating files and producing the correct braille trandlation
on their website.

2. Inserting existing images

In order to insert a design, move the caret to the position in the DBT text where you want to insert an
image. Select Layout > Picture > Add.., then select the desired TactileView design (.bpx file) and click
Open. Thetactileimage is now inserted in the DBT text file. The small yellow logo in the upper right
corner of the image indicates that the graphic was created in TactileView.
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Y ou can choose to insert an image either before or after tranglation of the braille document (ctrl+T).
Either way, the amount of space needed on the page for the image is automatically taken into account. If
the image istoo large to fit on the current page, it will be placed at the top of the following page. Any
empty white space around the edges of the TactileView design will be removed automatically for optimal

use of space. For the best results, make sure that the same embosser and paper size are selected in

TactileView and DBT. In TactileView, the red border indicates the available printable areafor the
selected combination of embosser and paper size.
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k- 4 The Duxbury Braille Translator - [Untitled Braille Document 1] = B
[®7 File Edit View Layout Table Document Global Help — || =
]

|| Current Style: None ||Page:2 ||Line:ﬁ ||Cu|umn:1 ||[<] | o

4. Editing inserted images
If you wish to edit the inserted tactile graphics, simply double click on theimagein DBT. Thiswill
launch the TactileView software, in which you can make any desired adjustments. Once you are satisfied,
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you can save the changes by clicking on the 'Insert design in external text file' icon in the top right corner
of the canvas area, or select File > Insert design in external text file.

[——]

Icon for Insert design in external text file: @3‘

5. Removing images
Y ou can remove inserted images by moving the caret position right after the image and pressing
backspace, or delete with the caret just before the image.

6. Printing combined text and graphicsfiles

An embosser that supports printing tactile graphicsis required for printing the DBT file containing the
images. In TactileView, you can see a preview of the graphic output of the selected embosser by selecting
menu View > Design mode: dot view, or by viewing the print preview.
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9.01 Accessibility with a screen reader (introduction)

The TactileView software is fully accessible with a screen reader. Due to its visual nature, creating a
tactile design from scratch is very challenging for VIP users. However, many other aspects of the
software can be used without the need for a sighted designer. This section will give an overview of the
suitability for screen reader users of different aspects of TactileView.

Accessible menus

All menus and dialogs are accessible. Some of the menus are specially designed for screen reader users.
Extra messages besides those of the screen reader itself are read out to provide additional explanations
where appropriate.

Make sure the Settings menu Speech has been covered to make full use of these audible messages.

M ouse/freehand drawing vs. Menu driven design

To follow see the mouse on screen in the drawing area of the software is virtually impossible, even if the
position of the mouse would be announced frequently. Keeping track of the created design isimpossible
with only speech and/or braille.

Existing images can be explored by analysing the colour composition, but how they are curved or the way
how the lines intersect cannot be explored without printing the design. Therefore, creating or modifying

‘free-hand’ drawing isastep too far.

As an alternative, objects such as squares, circles and straight lines can be added to the design. Their
positions are indicated by their properties (Ctrl+J).

Placing such an object can be done with the menu driven design menu (Ctrl+l).
Thingsthat work really well for a screen reader

Below you will find some of the ways to create a tactile diagram while using a screen reader that work
really well.

Creating digital designs by hand

Using the TactiPad drawing board would be a great alternative for creating tactile images asa VIP. Using
this board, you can create a tactile drawing by hand. When combined with a camera, you can take a
picture and digitally save your drawing or send it by mail. As amore advanced way of drawing, you can
digitize your manual drawing using the TactileView Digital pen.

Download and Edit Design from Catalog (Portal menu)

Y ou can use the catalog to find and download suitable tactile diagrams by selecting a category or
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searching for keywords in the title, textlabels or description.

Especialy the alternate text that was given by the designer to describe the design can help to determine if
thisisthe required design. The alternate text or description can be extended by any visitor of the catalog
to make the description more detailed.

See also the section 'Using the TactileView online catalog'.

Compose map (Portal menu)

To create atactile map, choose 'Compose map' from the Portal menu. Thiswill open a browser window
with the website www.routetactile.com, on which you can create a map of any specified area. Y ou can
find adetailed description of all that isinvolved to create a tactile usable map in the Tactile Maps section.
Create mathematical graphs (Graphs menu)

With a screen reader, you can create a graph of any mathematical formula. Y ou can either enter an
equation to create your graph or start from one of the sample graphs in the software. See also the category
Graphs and math in the TactileView manual.

Printing designs

Y ou can also print designs on swellpaper or with a braille embosser by choosing 'Print’' from the File
menu. Y ou can read more in the Printing section of the manual.
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9.02 Settings - Speech
In most cases, screen reader users will have a speech output for general computer access. For specific
applications, screen readers have functionality to monitor certain areas on the screen in order to provide

Speech output.

The TactileView software can also provide information that is helpful for a screen reader user from the
status line of the software or info related to al the many tools and objects.

When the TactileView software is extended with the TactileView digital pen and either the TactileView
ClickPad or the TactiPad drawing board, additional options for exploring audio-tactile diagrams or
creating digital drawings become available.

The operation of these additional options greatly depends on using a screen reader. The speech settings
are applied while using these extensions as well.

See a so the sections in the category 'Digital pen, TactiPad and ClickPad'
L anguage selection and Text-To-Speech (TTYS)

Textlabels and messages are displayed in the language that was selected in the 'Language’ dialog in the
Settings menu.

For announcing these texts, atext to speech (TTS) synthesizer has to be selected. Microsoft supplies a
few TTS engines with the Windows operating system. Extra TTS synthesisers can be installed from
Eloquence, Nuance, L&H or other vendors.

Volume and rate

The volume and rate of spoken messages can be set to find a match with the volume and rate with the
speech output of the screen reader. Use the 'Speak’ button to test the selected voice, rate and volume.

Speak application messages (select checked)

The software can provide messages in addition to a screen reader. These messages contain status
information about the drawing tools and properties of the objects. When you use TactileView with a
screen reader, the option 'Use text to speech for application messages and audio style' should be checked.

Speak audio style or text label upon object selection (Select checked)

When an object gets the focus (is selected) the type of object and some properties are announced. For
screen reader usage, 'Speak audio style or text label upon object selection’ should be checked.

Text to speech for different languages
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Some designs may contain texts in different |languages, making the text to speech difficult to understand.
If possible, it is best to use the TTS that matches the text label language.

For any languages in the list that show 'not defined', the default TTS synthesiser will be used. To apply a
specific TTS synthesiser for a certain language, select the language from the list, then select the TTS you
wish to usein the list below.
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9.03 Drawing tools- Menu driven design (Ctrl+L)

TactileView is designed to allow the user to create and edit objects solely through the use of the menus, a
feature referred to as “ menu-driven design.” This method of creating graphics takes some practice, as you
must decide where to place objects based on the distance of a specified critical point for each type of
object away from the top and left edges of the design.

Menu-driven design may be used to edit existing graphics or to create new ones. This tutorial describes
common functions for adding and editing objects in a drawing.

Adding objects

The drawing tools have been designed to use a coordinate-based drawing system. This means that each
time you select adrawing tool, adialog will appear that |ets you specify the location in which the object
will be inserted by inputting position and size information for that object.

Drawing straight lines

To draw astraight line, choose the Draw Straight Line option from the Drawing Tools menu. Thiswill

bring up adialog allowing you to specify the position of the start and end points of the line you want to
insert. Fill in the horizontal and vertical positions for the start and end points and enter the desired line

length, then choose the OK button to close the dialog and insert the line.

Drawing squar es and rectangles

To draw a square or rectangle, select the Draw Square-Rectangle option from the Drawing Tools menu.
Thiswill bring up adialog allowing you to specify the size and position of the square or rectangle you
want to insert. Fill in the desired position of the upper left corner of the shape. To specify the size, first
choose the Enlarge/reduce radio button if you want to insert square or the Stretch radio button if you want
to insert arectangle. Specify the width of the object. If you are inserting a square, you do not need to
specify the height. If you are inserting a rectangle, enter the desired height of the object. Select the OK
button to close the dialog and insert the object.

Drawing circlesand ovals

To draw acircle or oval, choose the Draw Circle-Ellipse option from the Drawing Tools menu. The
dialog that comes up allows you to specify the size and position of the circle or oval you want to insert.
Enter the position of the center of the circle. Next, choose either the Enlarge/reduce radio button to create
acircle or the Stretch radio button to create an oval. Specify the width of your object. If you are inserting
acircle, you do not need to enter the height. If you are inserting an oval, enter the desired height of the
oval. Select the OK button to close the dialog and insert the object into your file.

Drawing polygons

To insert a polygon, choose the Draw Polygon item from the Drawing Tools menu. A dialog appears,
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allowing you to enter the number of points you want in your polygon and define their positions. By
default the polygon starts with three points. Select each point from the angular points list and specify its
location. The software cal cul ates the angle from the previous point and the distance to the previous point
for you. Y ou can add more points by choosing the Add Angular Point button, and you can remove
unnecessary points by choosing Delete Angular Point. When you are finished, choose the OK button to
close the dialog and insert the shape.

NOTE: Pointsin the polygon can be added and deleted |ater when editing the shape with either the
context menu options or the mouse.

Drawing triangles

To insert atriangle into your drawing, select the Draw Triangle option from the Drawing Tools menu.
The dialog that appears allows you to select the type of triangle you want to insert (right, isosceles,
equilateral or scalene) and enter the positions of the points of the triangle. Select each point from the
angular points list and enter the desired position. The software cal culates the length of each line segment
touching the point, as well as the angle between them. When you are finished, choose OK to close the
dialog and insert the triangle into your file.

Adding arows and other figures

To add arrows or other commonly used shapes, choose Add Figure from the Drawing Tools menu. A
dialog containing alist of available figure categories including arrows, electrical symbols and more
appears. (NOTE: You can aso add your own commonly used shapes as figures so that you can easily
insert them into files. Please refer to the Adding Figures to the Figure Library tutorial for more
information.) Browse through the categories and select a figure to add, then choose OK.

Next a size and position dialog appears, allowing you to specify the position of the figure in your
drawing. Choose the Enlarge/reduce radio button if you want to lock the object’ s height with respect to
the width when choosing the size, or choose the Stretch radio button if you want to define the width and
height separately. Choose the OK button to close the dialog and insert the object into your file.

Drawing freehand lines

A true freehand line can be drawn accessibly using the digital pen with the software. However, you can
draw aline or closed shape point by point with the menu-driven design by choosing the Draw Free Hand
Line-Closed Shape option from the Drawing Tools menu. The same dialog that appears for the Draw
Polygon function appears for drawing freehand lines, allowing you to enter the number of points you
want in your line or shape and define their positions. By default the line or shape starts with four points.
Select each point from the angular points list and specify its location. The software calculates the angle
from the previous point and the distance to the previous point for you. Y ou can add more points by
choosing the Add Angular Point button, and you can remove unnecessary points by choosing Delete
Angular Point. When you are finished, choose the OK button to close the dialog and insert the shape.

NOTE: Pointsin the line or shape can be added and deleted later when editing it.
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Text labels

Y ou may add text format labels to afile at any time. There are several formats of labels available for use
in TactileView. The most commonly used type of label in TactileView isreferred to smply asa*“text
label.” Text labels may be entered in plain text and be automatically transated to braille when they
appear in the document, or they may be entered directly in braille through six-key input.

In addition to text labels, TactileView offers the option to add mammoth braille labels or print character
labels that will be embossed as raised text.

NOTE: Labels may only be edited according to the input method used to create them. For example, atext
label entered viabraille (six-key) input may only be edited using six-key, and araised print character
label may only be edited as araised print character label. Labels can’t be converted from one type of

label to another.

Adding text labels

The most commonly used type of label in TactileView isreferred to simply asa*“text label.” Text labels
may be entered in plain text, and then they are automatically translated to braille when they appear in the
document.

When using menu-driven design, text labels can be added either by choosing Add Text Label from the
Drawing Tools menu of the software, or by opening the List of Objects (Ctrl+L), choosing the Add Text
Label or Object button and selecting Add Text Label from the list of options.

A dialog will appear, allowing you to enter the text for your label, select the braille table to use for
trangd ation and input position information.

Enter the text you want to usein your label into the Contents box. Select the braille table to use for
trandation from the Select Braille Table for this Label combo box. [Note: For US English braille, select a
table starting with “en-us.” En-us-gl is the standard US English braille table for producing Grade 1
braille, and en-us-g2 is the standard one for US English Grade 2.]

Enter the location for the text label by editing in the Distance to Left Edge and Distance to Top Edge
fields. You can also control the width of the text label by specifying the maximum number of characters
you'd like it to have before the text wraps to the next line. Choose OK to close the dialog and insert the
label.

Adding text labelsthrough six-key entry

Currently this option is only available accessibly through the use of the digital pen. Please refer to the
Accessible Drawing Using the Digital Pen tutorial.

Adding mammoth braille labels

When using menu-driven design, mammoth braille labels can be added either by choosing Draw
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Mammoth Braille from the Drawing Tools menu of the software, or by opening the List of Objects
(Ctrl+L), choosing the Add Text Label or Object button and selecting Draw Mammoth from the list of
options. In the dialog that appears, enter the text you wish to appear in mammoth braille and specify the
position in which it should be inserted. Choose OK to close the dialog and insert the mammoth braille
label into your file.

Adding raised print character labels

When using menu-driven design, raised print character labels can be added either by choosing Draw

L etters and Digits from the Drawing Tools menu of the software, or by opening the List of Objects
(Ctrl+L), choosing the Add Text Label or Object button and selecting Draw Letters and Digits from the
list of options. This launches a dialog that allows you to enter the text you wish to appear as print
characters and specify its location in the drawing. Set the options as desired and choose OK to close the
dialog and insert the label into your file.

Editing objects
Selecting objects

To select an object in the current drawing, open the List of Objects dialog either by choosing Menu
Driven Design from the Drawing Tools menu (Alt+T, then M) or with the hotkey Ctrl+L. The List of
Objects dialog shows the complete list of drawing objectsin the current drawing by object type and gives
identifying information about each object. To select an object, arrow through the list until you locate the
object you want to work with.

If, after selecting an object, you select the OK button on the List of Objects dialog, the dialog closes and
the object you chose is selected. However, most common editing functions may also be performed
directly from the List of Objects dialog, and this is the recommended method when using menu-driven
design.

Copying, pasting and deleting objects
To copy an object, first press Ctrl+L to bring up the List of Objects dialog. Locate the object you wish to
copy, choose the Open Context Menu button and select Copy. The object has now been copied to the

clipboard.

To paste an object from the clipboard, choose Paste from the Edit menu (Alt+E, P) or press Ctrl+V. This
pastes the object centered at the upper left corner of the design.

To delete an object, first press Ctrl+L to bring up the List of Objects dialog. L ocate the object you wish to
delete, choose the Open Context Menu button and select Delete.

Moving and resizing objects

Select the object you wish to move or resize from the List of Objects dialog and choose the Open Context
Menu button. The context menu is slightly different depending on what object type is selected, but the
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position dialog can aways be accessed through the first context menu item, which will be Size and
Position, Text and Position or Positions of Angular Points. Select this item to bring up the same dialog
used to create the object initially, in which you can enter new locations for critical points in the object if
you wish to move the object, or enter new height and width settings for objectsif you wish to resize them.

Y ou can also center an object horizontally in the drawing by selecting it, choosing the Open Context
Menu button and choosing Center. Thiswill only automatically center the object horizontally; it will keep
the same vertical position on the page.

Rotating objects

Select the object you wish to rotate from the List of Objects dialog, choose the Open Context Menu
button and select Rotation. On the dialog that appears, enter the desired angle of rotation in degrees and
choose OK to rotate the object.

Changing object line properties

Select the object you wish to edit from the List of Objects dialog, choose the Open Context Menu button
and select Line Style. This opens adialog from which you can set the line properties for the object,
including the line pattern (solid or dashed) and thickness. The drop-down list for the line pattern describes
the number of pixels of black + the number of pixels of white that make up the line. For example, 2+2
means that the line will have two pixels of black followed by two pixels of white, while 5+3 will have
five pixels of black followed by three pixels of white (so that the line is a pattern of longer black lines
with shorter white spaces in between). Once you select the line patter, choose the thickness of thelinein
pixels. Choose OK to apply your changes to the object and close the dialog.

Changing object fill properties

Select the object you wish to edit from the List of Objects dialog, choose the Open Context Menu button
and select Fill Style. This opens a dialog from which you can set the fill properties, including selecting a
fill texture, scaling the size of thefill tiles and rotating the texture within the object.

If you would like to add afill texture to your object, select the Use Texture Fill radio button. Choose the
Change Texture button to bring up a dialog containing alist of textures that can be used. Select atexture
from the list of options and choose OK. Use the Tile Size in Pixels edit box to scale the texture larger or
smaller. You can also rotate the texture using the Texture Rotation Angle edit box. When you are finished
making changes, choose OK to apply thefill to your object.

Adding audio labels

Audio labels are agreat way to add more information to a drawing without having to make it larger to
accommodate more text or graphical information. The audio information is accessed by using thefilein
explore mode, either on screen with a mouse or on atactile copy on the Clickpad or Tactipad with the
digital pen. For more information on explore mode, please refer to the Using Explore Mode and Using the
Pen in Explore Mode with the Clickpad or Tactipad tutorials.
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Audio labels can be added to any type of drawing object in TactileView, and to mammoth braille or
raised print character labels. Audio labels may not be added to text |abels, because text labels are
automatically voiced by text-to-speech when the file is used in explore mode.

Adding an audio label to be voiced by text-to-speech

Select the object you wish to add an audio label to from the List of Objects dialog, choose the Open
Context Menu button and choose Audio Style. Thiswill launch an audio label dialog, the top section of
which allows you to specify the text to be voiced by synthetic speech from one of several sources.

In the “Text or document in synthetic speech (TTS) section of the dialog, the default choice is the Self
Defined Text radio button, which allows you to type the text you want voiced into the text field on the
dialog. If you have text saved in atext file that you would like voiced instead, you can select the Text
from Local File radio button, then choose the Browse button to browse to and select your text file. Once
you have specified the text, you can check how the label will sound by selecting the Test Audio Label
button. When you are finished making changes, choose the OK button to close the dialog and apply the
audio label.

Attaching an existing sound fileto an object

Y ou can also attach an existing sound file to an object to have it played when the object is clicked while
thefileisin explore mode. To do this, select the object you wish to add an audio label to from the List of
Objects dialog, choose the Open Context Menu button and choose Audio Style. Thiswill launch an audio
label dialog, the bottom section of which allows you to specify a sound file to play when the object is
clicked in explore mode.

In the “Insert sound sample from” section of the dialog, the default choiceisthe Local File radio button,
which is the one needed to attach a sound file to the object as a label. Select the Browse URL button,
locate the sound file you would like to use on your computer and select it. The file path to the sound file
will now appear in the text field below the sound file type selection radio buttons. Y ou can check how the
audio label will sound by selecting the Test Audio Label button. When you are finished making changes,
choose the OK button to close the dialog and apply the audio label.

NOTE: If you have both atext-to-speech audio label and a sound file audio label attached to the same
object, the text-to-speech will be voiced first and the sound file will play after it.

Recording an audio label from a microphone

Audio labels recorded from a microphone are played when the object is clicked with the mouse or digital
pen while using the file in explore mode. Recorded |abels are played after any text-to-speech labels are
voiced.

Before recording, you will need to ensure that you have a microphone connected to your computer. When
you have connected a microphone to your computer, you can record an audio label for an object by
selecting the object from the List of Objects dialog, choosing the Open Context Menu button and
selecting Record Microphone. An Audio Recording dialog appears, alowing you to select the
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microphone from which you wish to record, the format in which to record the sound, the location in
which to store the recording and the volume percentage at which to record. To begin recording, choose
the Start Recording button. To stop recording, press enter. To play back your recording, choose the Play
Recording button. If you wish to re-record your audio label, just repeat the recording process. Only the
most recent recording will be attached as the audio label for thefile.

NOTE: Each object may only have one text-to-speech audio label and one recorded or sound file audio
label associated with it. If you record an audio label for an object, it will replace any existing sound file
you may have associated with that object previously.

Editing an existing audio label

Y ou may edit any type of audio label by repeating the steps used to create the audio label.
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9.04 Browsing and selecting objects (Tab or Shift+Tab)

All objects that have been placed in the design with one of the drawing tools are grouped in the objects
list (Ctrl+M). From thislist, the respective context menus can be opened to change the properties of the
object.

Y ou can select an object or text label in the design by choosing it from thislist, then pressing 'OK'.
Cyclethrough text labels and objectswith Tab or Shift+Tab

To conveniently cycle through the objects and text |abels that are present in the design, use Tab (cycle
forward) or Shift+Tab (cycle backwards). One by one, the objects and text labels will get the focus (will

be selected). The name and position of the object or label will be announced.

Thisway you can cycle from top to bottom through the design. If any objects are horizontally aligned, the
objects further to the left will come first.

Use Ctrl+K or the enter key to open the context menu if you wish to make any changes to the object.
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9.05 View - Context menu (Ctrl+K or Enter)

Any objects that were placed in the design can be edited later on. Opening the context menu of a selected
object or drawing tool gives accessto all the properties that can be changed. Read 'Browsing and
selecting objects to find out how to make your object selection.

View - Open context menu (Ctrl+K or Enter)

Once you have selected an object in the design, you can open the context menu by choosing 'Context
menu’ from the View menu. Alternatively, you can press Ctrl+K or the Enter key as a shortcut to open the
context menu.

Open context menu via Object list (Ctrl+M)

The object list shows all object that are present in the design. Choose 'Open context menu' in this object
list dialog. The respective context menu will open, in which you will find all options to edit the properties

of the selected object.

See also the section 'Common properties of objects’.
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9.06 View - Show properties (Ctrl+J)

When an object is selected in the design, it can be very useful for screen reader usersto get aquick list of
all the properties. To can select an object in your design, choose either ‘Menu driven design’ from the
Drawing tools menu (Ctrl+L), or 'List of objects from the View menu (Ctrl+M). In either list, select the
object and press'OK'. The object now has the selection. The properties list of the selected object can be
opened by selecting 'Show properties in the View menu, or by pressing Ctrl+J.

Thelist of properties include aspects such as size, position in the design, etc. Use the button 'Speak
properties to hear the properties in a spoken message. If you wish to make any changes to the object,
choose 'Open context menu'.
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9.07 View - Play audio style (Ctrl+l)

When the selected object has been provided with an audio style, it can be played using the shortcut Ctrl+l
or by selecting 'Play audio style' from the View menu.

In the section 'Using audio styles you can read more about the use of audio styles.
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10.01 Introduction and prepar ation steps
Introduction
TactileView tactile graphics suite for VIP users.

In the sections in this category we elaborate on using the combination of all components of the
TactileView tactile graphics suite by avisually impaired person (VIP). The assumption is that the user is
using a screen reader with speech and/or braille output.

The addition of the TactileView software with adigital pen and either a TactiPad drawing board or a
TactileView ClickPad brings new possibilities with respect to tactile diagrams: creating digital designs by
aVIP and exploring audio tactile diagrams with more than just tactile information.

Skill level

Please be informed that using the TactileView digital pen requires a high level of experience. We strongly
suggest to follow the steps below in order to develop the necessary skills before starting to use the
product combinations with the digital pen. By following the steps, you will not be discouraged by the
learning curve that isinvolved.

Y ou can read more about the aspects of using the digital pen in the '‘Considerations' section.
Preparation steps

Asthe skill level of using the digital pen to operate TactileView and draw on the TactiPad isrelatively
high, it is very useful to build up agood comprehension of the different aspects separately before using
them together. The following steps will give an overview of the best approach to master using the digital
pen asaVIP user. By breaking it down into individual steps, we encourage you to explore the increasing
possibilities that the combinations of the productsin the Tactile graphics suite

1. Basic understanding - TactileView tactile graphics
1.1 It isabig advantage when you already have a good understanding for tactile diagramsin
general. Therefore we suggest to first to download and print pre-made designs from the
TactileView catalog, compose a map with RouteTactile or print graphs based on any equation.
Thisallows you to 'get afeeling' for exploring atactile diagram with your fingertips.
1.2 Make sure you can operate the software with a screen reader. Get familiar with navigating
through the menus and dialogs in the software using a screen reader and practise operating the
software with by downloading and printing designs from catal og.

2. Basic under standing - TactiPad

2.1 Practise creating a compl ete tactile drawing by hand on the TactiPad with aregular pen. You
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could start with a basic sketch to get afeeling for drawing by hand. Make sure to get familiar with
using the pen and drawing tools to create a tactile image.

Y ou can use the 'TactiPad user manual’ as a guide.
3. Preparing the hardwar e - Digital pen and TactiPad
3.1 Place the batteries in the digital pen.

3.2 Place the pen's receiver in its holder and with its magnets position it on the side of the
TactiPad.

3.3 Connect the USB cable to the receiver and your computer.
See the 'Digital pen user manual’ for all details on steps 3.1 to 3.3.

4. Preparing the software

4.1 Cover the different parts of the dialog "TactileView digital pen' in menu Settings.
4.2 Inthe 'TactileView digital pen’ settings dialog, test the connection of the digital pen.

4.3 How and where to place the receiver relative to the TactiPad or ClickPad and orientation
(landscape, portrait).

4.4 Calibrate the pen within the space for the TactiPad or ClickPad
Read " for a complete guide through steps 4.1 to 4.4.

5. Under standing the various actions and responses of the pen
5.1 Make sure you know where to point and how to click to navigate through the software using
the digital pen. Learn how to access context menus and select the menu options.
5.2 Make yourself familiar with the sounds and messages that signify over 20 pen functions. Be
aware of the state of the digital pen at all times (sounds and messages; the pen can have over 20

different functions; thisis a sub set of the functions that are available in the menus)

5.3 Understand how the surface (dimensions) of the TactiPad relates to the size of the drawing
area on the screen and vice versa.

5.4 Know when to use the computer keyboard or the menus that are accessible with the pen. There
IS no need to use the computer keyboard when operating the software with the pen, except for
entering texts.
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6. Start creating digital tactile drawings

6.1 Start by creating basic drawings with alimited number of objects using ‘Menu driven design'.
Creating or modifying an image by a VIP can only be done with a good comprehension of the
tools and their effects on an image. Using the TactileView digital pen requires that you understand
the tools from the 'Drawing tools' menu and are able to investigate the screen from the 'List of
objects in the View menu. Explore what the different objects will ook like when they are printed.

In general, you do not really use the tools such asruler, protractor and triangle to create an exact
drawing, but your drawing is based on the status information (object type, position etc.) in speech.
When drawing objects with the TactileView digital pen, you are not physically drawing the lines
of the objects on the TactiPad, but you are working with tactile reference points to mark the
various objects that you want to add to the digital design. The various objects are added to the
design and positioned aligned to these reference markers.
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10.02 TactileView graphics suite products
Functions of the digital pen in the design mode and in the explore mode

In this section, the basic operation of the different products is described. In separate sections, the
functionality will be explained when the pen and receiver are connected to create a drawing (design
mode) or exploring a audio-tactile diagram (explore mode).

TactileView digital pen

The digital pen enhances the functionality of the TactileView software for avisually impaired user. It
replaces and extends the use of aregular mouse.

The digital pen acts as a mouse to operate the software (by clicking opening menus and sel ecting options)
or asapeninabordered area, similar to adigitizer.

The digital pen itself resembles an ordinary ballpoint pen. In the tip we can find atiny transmitter that
transfersasignal to areceiver. Thereceiver is placed alongside the TactiPad or the ClickPad and is
connected via USB to the computer. Viathe receiver, the position of where the pen iswithin the surface
of the pad is transmitted. Just like a regular mouse, you can click by pressing down with the pen
anywhere on the surface (thetip is pushed inward dlightly).

See also the section 'Operating the TactileView digital pen'.

TactiPad drawing board

The TactiPad can be used to create free-hand drawings or more exact drawings with the help of the tools
(ruler, protractor, triangle and compasses). The GraphGrid and CircleFrame accessories extend the range
of drawings that can be made even further. These devices can be used by all age groups, starting from the
age of 4.

Depending on the age and the purpose of the diagram, it can be more exact for teaching basic concepts,
for explaining and teaching math and science or for fun drawing in which precisenessis required. On the

other hand, the TactiPad can also be used for a quick sketch.

The TactiPad is specifically useful as avaluable and convenient method of communication between a
VIP and a sighted person.

See also www.tactipad.nl

TactileView ClickPad

The ClickPad holds printed audio-tactile diagrams (tactile graphics that contain audio information objects
with audio style) and is available in various sizes for different paper sizes. For more information, read the
section 'What is an audio tactile diagram'.
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TactileView design —and production software

The software isin the first place aimed towards a sighted user. However, it isfully accessible with a
screen reader. All menus and dialogs have short cut keys. The software has functionality to support screen
reader users. Extra menus become available in the software when the digital pen is connected.
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10.03 Consider ations

As mentioned in 'Introducing the TactileView tactile graphics suite', using the TactileView digital penin
most cases requires a high level of experience. We strongly suggest to practise the various skillsin a
certain order to develop the necessary skills before starting to use and combine the productsin the
TactileView Graphics Suite.

Depending on the amount of support at hand, we recommend to take care of some preconditions to avoid
disappointment in using the TactileView digital pen. Make sure al sections in the category 'Using
TactileView with a screen reader’ are mastered as well.

Why drawing with the digital pen on the TactiPad?

Do you wish to digitize the drawing that you create on the TactiPad drawing board? Do you want to share
your digital designs with others for further processing? Or do you want to use the objectsin TactileView
for more accuracy in your drawings?

If you answered 'yes' to any of these questions, there are specific advantages to using the digital pen to
combine the functionality of both TactileView and the TactiPad. In other cases, the separate use of both
products will usually be sufficient.

Keep in mind that the skill level of the combination of productsis

Please note, we bring up this question while the effort involved in to creating adigital design isrelative
high.

Why using a TactileView ClickPad?

By its nature, braille characters have afixed size that takes up arelatively large amount of spacein a
tactile graphic. For diagramsin which many (braille) text labels are required, the addition of an audio
information layer can help to reduce the amount of space needed for text information. Specific areasin
design can be provided with audio labels that provide spoken information. When clicking with the digital
pen on the position of the audio style, its content will be pronounced. The audio content can be text (using
Text to speech) as well as music or microphone recordings (.mp3 files).

See the section 'Adding audio styl€' to find out how audio styles can be added to the design.
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10.04 TactileView digital pen - Basic operation
Initial rest state

Initialy, the digital pen will beinits 'rest state’, in which nothing will be drawn in the software when
moving or pressing down with the pen. Thisway, any unintentional "pen contact' (pressing down with the
pen tip) will not yet cause any changesin the design. The rest state of the pen is announced by atinkling
sound when pressing down.

In order to change the operation/function of the pen, open the context menu by pressing the pen down
anywhere on the surface for 1 second. Y ou will hear a sound of five ascending tones. After the fifth tone,
the context menu is opened. Releasing the pen before the last tone was played will not open the context
menu. This allows you to cancel before unintentionally opening the menu.

Selecting an option from the context menu

After the context menu has opened, the pen is used to operate the software by cycling through the
available options and making a selection. The selected option will be pronounced by the screen reader.

The context menu both contains functions for drawing on the TactiPad, as well as exploring audio tactile
diagrams on the ClickPad.

Audio reading system with TactileView digital pen and ClickPad

In the explore mode (Ctrl+E), the audio information in audio-tactile diagrams can be explored. The
printed design is placed on the ClickPad and the corresponding digital design isopened in TactileView.
By clicking with the pen in the tactile diagram, any audio information that is present at this position is
activated.
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10.05 Using Explore M ode (ClickPad)

Explore mode allows you to interact with a TactileView file the way a user will. For example, when you
click atext label in afile while using explore mode, the text label will be voiced via text-to-speech
instead of becoming selected so that you can edit it like it does in design mode. Similarly, the audio labels
for drawing objects will play when the object is clicked, instead of the object becoming selected for
editing.

Limited options for changing audio information in the file are available within explore mode, but
otherwise files cannot be edited from this mode. If you would like to make changes to anything else in the
file, you must switch back to design mode to do so.

Y ou can control some user settings from explore mode, such as selecting a voice or initiating digital pen
calibration. For information on calibrating the digital pen or using it with afile in explore mode, please
refer to the Connecting and Calibrating the Digital Pen and Using Explore Mode with the Digital Pen
tutorials.

Entering explore mode

In order to use afile in explore mode, you must first open it in TactileView, which defaults to design
mode when afile is opened. Once you have afile open, explore mode can be activated in one of three
ways. by selecting the Explore with Speech and Sound icon from the tool bar across the top of the screen,
by selecting the Explore with Speech and Sound option from the View menu or by pressing CTRL+E.

Exploring afile

When you first open afile in explore mode, certain information about the file is automatically voiced.
The name of the currently selected speech voice is spoken, as well asthetitle of thefile. TactileView aso
tells you how many audio styles (audio labels) are in the file when you first enter explore mode.

Y ou can explore the file by clicking different items in the file with the mouse. The digital pen provides an
accessible way to explore the file. For more information on using the digital pen with TactileView filesin
explore mode, please refer to the Using Explore Mode with the Digital Pen tutorial.

When you click on atext label, the text in the label is spoken via text-to-speech. When you click on an
object with an audio label, the audio label is played. If the audio label contains both synthesized speech
and a sound file, the synthesized speech will begin first and then the sound file will play. Clicking on a
blank area or on an object other than atext label that does not have an audio label will cause TactileView
to voice “empty.”

Changing an object’s audio label
If you discover an object that does not have an audio label and want to add one, you can right-click it and

choose Change Audio Style for Object option from the context menu. This brings up the audio label
properties dialog, which allows you to create an audio label the same way you would in design mode. For
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more information on the options on this dialog, please refer to the Adding and Editing Audio Labels
tutorial. When you are done making changes, choose the OK button to close the dialog and apply your
audio label.

Y ou can also edit existing audio labels for an object by right-clicking the object and choosing Change
Audio Style for Object from the context menu to bring up the audio label properties dialog. Make any
desired changes on this dialog, then choose the OK button to close the dialog and apply your changes to
the audio labdl.

Adding a voice memo

Sometimesit can be useful to add an audio label without attaching it to adrawing object. Thisis
especially true when the file you' re working with is afused bitmap, because nothing in afused bitmap is
selectable. Thistype of audio label, called a voice memo, is shown in the file and can be clicked to hear
the audio information, but it will not be embossed in the drawing when the file is embossed.

To add avoice memo, right-click anywhere in the file and choose the Place V oice Memo option from the
context menu. To define your voice memo area as asmall circle, click the place in the file where you' d
like the voice memo to be. To create aline as the voice memo area, click and drag the mouse to draw the
line, then release it. To create a freehand closed shape as the voice memo area, click and drag the mouse
to draw the shape, releasing the mouse button close to the starting point of the freehand shape object.

As soon as you have defined the voice memo area, the software will begin recording from the computer’s
microphone to create the voice memo content. If you wish to record from the microphone for your voice
memo, begin speaking into the microphone immediately and then click anywhere in the file to finish
recording. If you would like to create a different type of voice memo, simply click anywhere in thefile
after defining the voice memo area to quickly end the recording process, then right-click the voice memo
areato bring up the standard audio label properties dialog and define your audio label as desired.

Setting the voice for text-to-speech

To choose a different voice for synthesized speech for audio and text labels, right-click anywhere in the
file, pick the Select a voice option from the context menu and choose the desired voice from the pull-
down list to the right. TactileView will immediately begin using the newly-selected voice for synthesized
Speech.

Exiting explore mode

When you wish to return to design mode, press ESC on the keyboard or right-click anywherein the file
and choose Quit Explore Mode in the context menu.
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11.01 Printing with a braille embosser

Before printing afile from TactileView, ensure that the driver for your embosser has been installed onto
the computer. Once you have verified that the printer driver isinstalled on the computer, select Print
Setup from the file menu. Thiswill launch the Print Setup dialog.

From the Printer Name list, select your embosser. Next, select the paper size you want to emboss on, and
choose the print orientation. Select the OK button to save your settings and close the dialog.

If you changed any of the options on the screen, it may affect how your document will print. Depending
on the size of your design area and whether it was sized for the paper size you're using, the file may not
make full use of the available space on the paper, or the design may run over dlightly onto a second page.
Check how your document will print by selecting Print Preview from the File menu. Thiswill open a
preview of how your document will print.

Across the top of the screen are severa print preview buttons arranged in atool bar just above the area
that usually contains drawings. If the Next Page button is available, this means that your document is
currently configured to print on more than one page. Use the Next Page button to switch the view to the
next page that will be printed, or use the Two Pages button to display two pages of your file at atime.
When in two page preview mode, the Two Pages button will change to a One Page button to alow you to
switch back to one page preview mode. When you are finished previewing your file, choose the Close
button to close the preview. If you need to adjust the design area to fit the paper size, please refer to the
Changing Design Size and Orientation tutorial.

Once your document appears in the preview the way you want it to print, select Print from the File menu
or press CTRL+P to bring up the Print dialog. Thisis a standard Windows print dialog, which alows you
to select which pages to print and how many copies you would like printed. Make the desired selections,
then choose the OK button to close the dialog and print thefile.
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11.02 Printing on swellpaper (microcapsule paper)

Swellpaper or microcapsule paper is a heat sensitive paper and contains chemical ingredients that will
create volume wherever there is black ink printed.

Once the design has been printed with an ink jet printer, the paper has to go through a special oven. In
this process, the paper will ‘swell” wherever black ink was printed. Laser printers are not recommended
for swellpaper, as damage might be caused if the heat of the laser printer causes the paper to swell.
Whereas braille embossers will use lines made up of individual braille dots, designs printed on swell paper
have more fluid, continuous lines that retain more detail.

Braille dot diameter and paper variances

Swellpaper produced by various companies have slightly different properties in terms of the required
temperature and duration of the temperature exposure. It takes some experience to find the optimal
settings for the particular paper that you are using.

Depending on the oven temperature, the braille dots might not raise enough or they will be raised too
much so they are no longer distinguishable as individual dots. To compensate for this effect, the diameter
of the dots can be adjusted by choosing Text label presentation on print' from the Settings menu and
increasing or decreasing the size of braille dots.

Printing text combining normal font and braille

The normal font (visual characters) of braille labels can be printed in alighter colour that will not raise.
Make sure to select another colour than black in "Text label presentation on print' to avoid the text being
raised.
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11.03 Printing multiple designs; booklet

TactileView includes a convenient tool that allows you to consecutively print multiple designs. This
option can be accessed by choosing 'Print multiple designs from the File menu.

Tip: abound booklet can already signify the page orientation, so in some cases it may be beneficial to
switch off the right-up marker for the document.

Preparingtheprint list asa TXT file

In afew steps, you can easily create a print list. Y ou can choose between a direct selection of the printed
files (1a) or preparing the print list in advance (1b).

la. Multiplefile selection

In the dialog that opens, you can select the files that you wish to include in your print list. Hold down Cirl
to add single designs to the selection, or hold Shift to add consecutive files. Once you have al the files
selected, click ‘Open'.

The next dialog allows you to save the file selection as a .txt print list. Thislist needs to be saved in the
same folder that contains the selected designs. Enter afile name and click 'Save' to confirm. If you do not
wish to use the print list again later on you can also skip by clicking 'Cancel'.

1b. Use a previoudy prepared print list (TXT file)

Y ou can create a print list in advance with any text editor such as Word or Notepad, or select aprint list
that was created previously following the stepsin la

Each line in the print list must contain one file name, including the .bpx file extension. If thefileis
located in a subfolder, include this before the file name, followed by aforward slash. Make sure that al
file names are correct, including any spaces or punctuation marks. Designs can be included multiple times
if necessary. Your print list should look like this:

file name 1.bpx
subfoldername/file name 2.bpx
file name 3.bpx

Save your print list asa.txt filein the folder that contains the TactileView designs. In TactileView, select
'Print multiple designs from the file menu, then choose 'Single selection: list with file names (*.txt)' and
select your saved print list. Click 'Open'’ to continue.

2. Select print order

In the next dialog, you can select the order in which the designs should be printed. Y ou can choose
'Original order' to print the designsin the order in which they are included in the print list. 'Reversed
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original order' can be used to ensure the last file in the print list is on the bottom of the stack.
'Alphabetical order' and 'Reversed aphabetical order' can be especially useful is the file names already
include ordered numbering.

Any filesin thelist that cannot be located will not be printed. The print job will continue with the next
file namein thelist.

Text and graphics combination
TactileView has the option to embed designs in atext document that was created with the Duxbury
Braille Trandator (DBT). When using DBT, you can use more advanced lay-out features such as page

numbering, headers and footers, etc.

See: Inserting graphicsin Duxbury Braille Trandator
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11.04 Paper sizevs. design size

The maximum paper size that printers generally can handleis A4, A3, US Letter or Tabloid. However,
diagrams can be larger than the maximum paper size when an image needs to be enlarged to retain the
level of detail in the original image. Multiple sheets can be placed in rows and or columnsto allow for
tactile diagrams of any large size.

In your designs, the red paper border will indicate the size of the design and the number of sheets.

LN

R Eedt s LA

Figure 1. The map is printed across two sheets of paper side to sidein order to include sufficient detail.

Be aware that resizing the design, changing the paper orientation or adding or removing space within the
design may unintentionally cause it to extend beyond the size of one sheet of paper. Once more, the
design will be printed on two sheets of paper, but the second page will only contain the right-up marker.
The red borders will indicate this on screen. Use the purple markers along the sides of the design to make
it fit whithin a single sheet of paper.
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Figure 2. The white area of the design extends slightly beyond the red border marking the paper size.
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